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Getting Started



Section 1A

Setting Up Service

� System Requirements (page 2)
� Installing the Drivers for Wireless Devices (page 3)

� Launching Sprint SmartView (page 4)

� Device Activation (page 4)
Setting up service is quick and easy. This section walks you through installing device drivers, 
installing the Sprint SmartView software, launching the software, and getting connected.

System Requirements

The minimum system requirements for installation and operation of Sprint SmartView are 
shown in the table below.

Processor 300 MHz
800 MHz (1 GHz 
recommended)

1 GHz

RAM 256 MB
1 GB (2 GB 

recommended)
1 GB (2 GB 

recommended)

Hard Drive Space 70 MB 70 MB 70 MB

Internet Explorer IE 5.5 (or higher) IE 7 (or higher) IE 8 (or higher)

Windows Service Pack
Service Pack 3 

(or higher)
Service Pack 2 

(or higher)
-

Additional Requirements
● Windows Vista and Windows 7 operation require DirectX 9.0 (or better) Graphics 

Accelerator

● Internet Connection (if downloading the installer from the Internet)
● CD-ROM (if installing from CD)

Windows XP Windows VIsta Windows 7
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Installing the Drivers for Wireless Devices

Before you connect with a wireless device, you will need to ensure that the device’s drivers 
are properly installed.

WiFi Devices
If a WiFi device came preinstalled on your computer, its drivers have most likely already 
been installed by the computer manufacturer. 

If you purchased a WiFi device separately and have not already done so, you should install 
the drivers for the device before proceeding.

Sprint Mobile Broadband Devices
All Sprint Mobile Broadband devices come with a printed Quick Start Guide or Get Started 
Guide that contains instructions for device setup, including driver installation, which typically 
involves the following steps:

1. Plug the device into the appropriate PC Card, ExpressCard, or USB slot. You will see a 
small icon at the bottom right of the screen indicating that Windows has discovered 
new hardware, and that the device drivers are being installed for it.

2. After the installation finishes, you will receive a confirmation message at the bottom 
right of your screen stating that the new hardware was installed successfully and is 
ready to use.

Note: Follow the instructions included with your Sprint Mobile Broadband device. Many devices will 
instruct you to install the Sprint SmartView software before inserting the device into your computer.

Installing Sprint SmartView

Your Sprint Mobile Broadband device includes a copy of Sprint SmartView, residing either 
on the device or on an installation CD.

If the installer is preloaded on your device, you will be prompted to install Sprint SmartView 
when you connect the device to your computer.

If your device came with an installation CD, simply insert the CD in your computer’s 
CD-ROM or DVD-ROM drive, and the installer should run automatically.

Note: The Sprint SmartView software can also be downloaded from www.sprint.com/downloads.

For detailed instructions on installing Sprint SmartView, consult the printed Quick Start 
Guide or Get Started Guide.
Setting Up Service        3



Launching Sprint SmartView

Once your hardware is installed and ready to connect, you may go ahead and launch Sprint 
SmartView by doing one of the following:

● Double-click the Sprint SmartView icon ( ) on your computer’s desktop.

– or –

● In the Start menu, select Programs or All Programs > Sprint > SmartView > Sprint 
SmartView.

Device Activation

Some Sprint Mobile Broadband devices may require activation (programming) prior to use. If 
your device needs activating, Sprint SmartView will inform you and start the activation process 
when you connect the device. Although the activation process will vary depending on the make, 
model and firmware version of your device, all activations fall into one of the following 
categories:

● Hands-Free Activation – Sprint SmartView will simply inform you that it is activating your 
device and periodically give you updates about activation status. No intervention is 
required on your part. 

● One-Touch Activation – Sprint SmartView will display a pop-up window that indicates that 
your device requires activation/programming and asks you if you would like to activate/
program the device now. Click Yes to activate your device.

If you choose to cancel activation at this time (by clicking No), you can restart activation 
by disconnecting the device from your computer and then attaching it again. One-Touch 
Activation can also be restarted by selecting Activate Device from the Tools menu. (See 
“Device Properties Window: CDMA Version” on page 93 for more information.)

● Activation Wizard – For some devices, Sprint SmartView will display an Activation Wizard 
when the device is connected. Although such devices require a few more steps to 
activate than those that use the techniques mentioned above, the wizard provides clear, 
step-by-step instructions to guide you through the process. 
Although you have the option to cancel the activation process at any time, you will not be 
able to use the device for data connections until it has been successfully activated. To 
restart activation after you have cancelled, just disconnect your device from your 
computer and then attach it again.

The Activation Wizard is accessible from the Tools menu by selecting Activate Device. 
Anytime there are problems with your connection, or for new service, you can go through 
this wizard. 
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Activation Wizard Tutorial
Follow these steps to use the Activation Wizard. 

Note: This procedure can only be used to activate devices that employ the Activation Wizard. It cannot be 
used to activate devices that employ one-touch or hands-free activation methods.

1. Connect your device to your computer by inserting it into the appropriate port (USB, 
PCMCIA, or ExpressCard).

2. Open the Sprint SmartView application.

3. Select Activate Device from the Tools menu in the Sprint SmartView main window. The 
Activation Wizard window as shown below will open.

4. Read the text in the Activation Wizard window and collect the required personal 
information according to the instructions in the window.
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5. Click Next to proceed to the next page of the Activation Wizard.

6. Follow the instructions in this window for entering your Activation Code (or MSL).

7. Write down the Electronic Serial Number (ESN) shown on this page of the wizard.

8. Click Next to proceed to the next page of the wizard. 

This page tells you that your Activation Code has been accepted, and instructs you to 
enter the Phone Number (MDN) and the MSID (IMSI_S) that the Sprint Customer Service 
representative gave you in step 4.

9. Enter the requested information in the spaces provided.
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10. Click Next. The Activation Wizard will display the Confirmation dialog shown below.

11. Verify that the numbers you entered in the previous window are the numbers that 
appear in this Confirmation dialog.

� If the numbers are correct, click Yes. The next page of the Activation Wizard will 
appear. Proceed to Step 12.

� If the numbers are not correct, click No. The Activation Wizard will take you back to 
the previous window so you can correct your entries. 

12. The final page of the Activation Wizard informs you that it will take approximately four 
hours to activate your device.

Since the Finish button will be disabled until network services are available, leave your 
computer on and the Activation Wizard open until the Finish button is enabled (it will 
have a black border and text, not a gray border and text).

13. Click Finish to close the Activation Wizard.
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Section 1B

Getting Connected

� Manually Establishing Connections (page 8)

� Returning to Automatic Mode (page 9)
By default, Sprint SmartView will automatically select an available network and establish a 
connection based on the priorities specified in the Network Profiles window. See “Network 
Profile Priority” on page 66 for a discussion of how this works.

Note: This is one of two autoconnect features provided by the Sprint SmartView software. The other 
autoconnect feature is described on page 25.

However, you can also manually select a network with which to establish a connection.

Manually Establishing Connections

You can manually establish a connection by doing any of the following:

● Click one of the Connect buttons in the main window to establish a connection using the 
associated technology.

Connect Buttons

    

● Select a network profile from the menu that appears when you click My Networks. (This 
menu lists ALL available network profiles.)

● Select a network profile from the list in the Network Profiles window and then click 
Connect.

See the “Manually Connecting....” topics in the sections dedicated to particular connection 
technologies for more information on establishing manual connections.
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Returning to Automatic Mode

Manually connecting to a network will disable automatic connection for that technology. 
However, you can re-enable automatic connection mode for all technologies if you wish: 

● If the Auto button is currently dimmed (off), click this button once to turn automatic 
mode on.

● If the Auto button is currently illuminated (on), click this button once to switch 
automatic mode off for all technologies. The button will dim. Then, click the button 
again to re-enable automatic mode.
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Section 1C

Getting Help

� Visiting the Sprint Website (page 10)
� Contacting Sprint Customer Service (page 10)

� Troubleshooting (page 10)

This section describes where you can find more information on Sprint services, options, and 
troubleshooting problems you have encountered.

Visiting the Sprint Website

Stop by www.sprint.com and log on to get up-to-date information on Sprint services, options, 
and more.

You can also:

●  Review coverage maps.

●  Access your account information.
●  Add additional options to your service plan.

●  Purchase accessories.

●  Check out frequently asked questions.
●  And more.

Contacting Sprint Customer Service

You can reach Sprint Customer Service by:

● Logging on to your account at www.sprint.com.

● Calling us toll-free at 1-888-211-4727 (personal use) or 1-800-927-2199 (business use).

Troubleshooting

The Online Help for Sprint SmartView (select Help from the Help menu) includes descriptions of 
most common error messages. Look in the Table of Contents under Troubleshooting. 
Additionally, you’ll find that most of the content in this guide also appears in the Help system.

For help with other problems:

● See section 7, “Troubleshooting and FAQ” on page 105. It describes a number of 
informational tools included in Sprint SmartView that may be of help in diagnosing 
problems. Additionally, it describes techniques that can be used to resolve the most 
common problems.

● Contact Sprint as noted above.
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Section 2A

The Main Window

� Basic Layout (page 12)
� The WiFi Control Panel: In Detail (page 15)

� The Mobile Control Panel: In Detail (page 16)

� Connection State (page 18)
This section describes the Sprint SmartView main screen, its controls, and the connection 
status information it displays.

Basic Layout

Privacy
Indicator

VPN
Indicator

GPS
Indicator

GPS
Search Menu

View Your
Account Info

Application
Launch Menu

Manually
Select a
Network

Mobile
Control
Panel

WiFi Control
Panel

Automatic
Mode Indicator

  

WiFi Control Panel
This panel is used to connect to and disconnect from WiFi networks. (See “The WiFi Control 
Panel: In Detail” on page 15 for more information.)

Privacy Indicator
This icon appears when a mobile broadband device that supports GPS has been attached. 
When no such device is present, the icon does not appear.

If a red slash appears across this graphic, a device that supports GPS is present, but its GPS 
functions are disabled. This is also called “privacy mode” because the device is not exchanging 
information about your location with the network. To exit privacy mode and enable GPS 
functions, click the GPS indicator to turn it yellow (or white).
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VPN Indicator
Click this icon to log on to a Virtual Private Network (VPN) using the settings configured on 
the VPN tab of the settings window. The indicator will turn orange and spin while VPN client 
software is being launched. It will turn yellow upon successful connection to the desired 
VPN.

GPS Indicator
This icon indicates whether GPS functions are enabled on your device.  

(gray)

GPS and sharing disabled. In this state, GPS data is not received by the Sprint 
SmartView application.

(yellow)

GPS enabled/sharing disabled. GPS data is received by the Sprint SmartView 
application, but the received data is not shared with third-party GPS applications.

(white)

GPS and sharing enabled. In this state, GPS data is received by the Sprint 
SmartView application and data is shared with third-party GPS applications using 
the NMEA protocol.

Hover over this icon to view the data received from your GPS device. Click the arrow to the 
right of it to open the GPS Applications menu (see page 55). Click the icon itself to enable 
and disable GPS data sharing.

Note: This icon will not appear if your device does not contain a supported GPS receiver or if GPS has 
been disabled entirely by selecting the Disable GPS on Device check box on the Location/
GPS tab of the settings window (see page 98). 

Automatic Mode Indicator
Normally, the Sprint SmartView software will select a network to connect to using the criteria 
described in “Network Profile Priority” on page 66 and then proceed to establish a 
connection to that network automatically.  However, it will switch to manual connection 
mode for an individual connection technology when you manually connect or disconnect 
from a network that uses that technology.

The Automatic Mode Indicator lights up when the automatic connection feature is enabled. 
It will remain lit as long as the overall feature is enabled, even if automatic connection for 
specific technologies has been disabled by manually connecting or disconnecting.

● Click this indicator to disable the automatic connection feature for all technology 
types. The indicator will dim. 

● Click this indicator again to re-enable automatic connection for all technology types. 
The indicator will illuminate once more.
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My Networks
Click this button if you would like to manually select a network to connect to. This displays a list 
of all networks that are available for connection. They are listed in the following order:

1. Networks for which a profile has been created, in order of priority.

2. WiFi networks for which you do not currently have a profile.

Mobile Control Panel
This panel is displayed if you have a 3G or 4G Sprint Mobile Broadband device attached to 
your computer (or if your computer has such a device built in). It is used to connect to and 
disconnect from 3G and 4G networks. (See “The Mobile Control Panel: In Detail” on page 16 
for more information.)

My Account
When you are connected to the Internet, you can click this button to be taken to a page that 
allows you to view your Sprint Mobile Broadband account information.

GPS Search Menu
If your device supports GPS, you can search for nearby restaurants, hotels and other amenities 
using this menu. To perform a search, just type what you are searching for in the space 
provided or select one of the predefined searches from the menu. (See “The GPS Search 
Menu” on page 54 for more information.)

Application Launch Menu
Quickly launch commonly used applications by selecting a desired application from this menu. 
Additional applications can be added to this list using the App Launcher tab of the settings 
window. (See “Launching External Applications” on page 42 for more information.)
14        The Main Window



Th
e 

M
ai

n 
W

in
do

w

The WiFi Control Panel: In Detail

The WiFi Control Panel is used to establish connections to WiFi networks. 

Connection
Status Text

Connection
Status Indicator

Click here to connect
or disconnect

Connection
Timer

Signal
Strength

WiFi Protocol
Indicator

  

Note: This panel will not appear if Sprint SmartView’s WiFi support has been disabled. To re-enable WiFi 
functions, select the Use this as my default WiFi management utility check box on the Client 
tab of the Settings window (see page 89).

Connection Status Indicator
The color of this icon is a visual indication of the connection state for the corresponding 
technology. See “Connection State” on page 18 for a detailed explanation of the various 
possible states.

WiFi Protocol Indicator
This indicator displays the WiFi protocol used by a network you are currently connected to. 
There are three different protocols:

● 802.11a - provides over the air transmission speeds of up to 54 Mbps in the 5 GHz 
frequency band.

● 802.11b - provides over the air transmission speeds of up to 11 Mbps in the 2.4 GHz 
frequency band.

● 802.11g - provides over the air transmission speeds of more than 20 Mbps in the 2.4 
Ghz frequency band.

● 802.11n - provides over the air transmission speeds of more than 50 Mbps in the 2.4 
GHz and/or 5 GHz frequency bands.

Signal Strength
This gauge shows the strength of the signal being broadcast from the currently selected 
network. Stronger signals tend to produce more reliable connections.
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Connection Timer
This timer indicates how long you have been connected to the currently selected network. The 
timer only appears when you are currently connected via the selected technology type. 

Note: The timer can be hidden by clearing the Display Connection Timer check box on the Client 
settings tab.

Connect / Disconnect
Click this button to connect to (or disconnect from) the network whose name is currently 
displayed in the connection status area.

Connection Status Text
A brief textual description of the connection status for the currently selected network (for 
example, “Ready to Connect” or “Connected”). This also usually includes the name of the 
current network. However, some states (such as “No Device Detected”) are not network-specific.

The Mobile Control Panel: In Detail

The Mobile Control Panel is used to establish connections to 3G and 4G mobile networks. Click 
any item in the illustration below for more information.

Connection
Status Text

Connection
Status Indicator

Click here to connect
or disconnect

Connection
Timer

3G/4G Technology
Button

Signal
Strength

Roaming
Indicator

Roaming
Banner

Mobile Protocol
Indicator

Connection Status Indicator
The color of this icon is a visual indication the connection state for your device. See 
“Connection State” on page 18 for a detailed explanation of the various possible states. The 
image on the icon indicates whether 3G or 4G mobile technology is selected:

3G Mobile

4G Mobile
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Roaming Banner
If you are roaming off of the Sprint network for a 3G connection, additional information 
about your roaming state may be displayed here. It is not displayed for a 4G connection.

Mobile Protocol Indicator
This indicator displays the mobile broadband data protocol (“bearer type”) used by a 3G 
network you are currently connected to. (See “3G Bearer Types” on page 28 for more 
information.) This is not displayed for 4G connections (WiMAX is the only 4G bearer type 
supported).

Roaming Indicator
This icon appears for 3G mobile broadband connections if the currently selected network is 
a roaming network. In other words, you will be roaming off the Sprint network if you connect 
to this one. Consult your wireless service plan for more information about roaming.

Signal Strength
This gauge shows the strength of the signal being broadcast from the currently selected 
network. Stronger signals tend to produce more reliable connections.

3G/4G Technology Button
This button appears if you have both a 3G mobile device and a 4G mobile device attached 
to your computer (or a single device that supports both types of connection). Click it to 
switch from 3G mode to 4G mode (and vice versa). Note that if you have a dual-mode 
device that supports both of these functions, there will be a brief delay while the device 
switches modes.

Connection Timer
This timer indicates how long you have been connected to the currently selected network. 
The timer only appears when you are currently connected via the selected technology type.

Note: The timer can be hidden by clearing the Display Connection Timer check box on the Client 
settings tab.

Connection Status Text
A brief textual description of the connection status for the currently selected network (for 
example, “Ready to Connect” or “Connected”). This also usually includes the name of the 
current network. However, some states (such as “No Device Detected”) are not network-
specific.
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Connection State

Each button indicates its corresponding technology’s connection status by changes in 
brightness or color

Connected. Sprint SmartView is connected using this technology.  

Ready. Sprint SmartView is ready to establish a connection using this technology. 

Not Ready. Sprint SmartView is NOT ready to establish a connection using this 
technology. This state will be displayed briefly while the device is being initialized. If it 
continues to be displayed, there is most likely a problem with the device or with network 
availability. A brief description of the specific state will appear in the Connection Status 
Text area. 

.

Selecting Alternate Networks
Click the arrow ( ) to the right of a connection state indicator to display a list of the currently 
defined network profiles for the corresponding technology. Click any profile in the list to 
establish a connection with that profile. (See “Network Profiles” on page 65 for more information 
on creating and using network profiles.)
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Section 2B

Menus in the Main Window

� The File Menu (page 19)
� The Tools Menu (page 19)

� The Help Menu (page 20)

� Username and Password Logon Window (page 21)
This section describes the menus that are accessable from the main window.

The File Menu

Clicking File in the menu bar of Sprint SmartView’s main window opens a short menu with 
the following options:

● Enable Airplane Mode – Selecting this item disables all adapters. An airplane icon will 
appear in the main window to indicate that airplane mode has been engaged. Click 
this icon or select the menu item a second time to return to normal operation.

● Exit – Exit the Sprint SmartView application.

The Tools Menu

Clicking Tools in the menu bar of Sprint SmartView’s main window opens a menu with the 
following options:

Note: WiFi-related items will not appear in this menu if Sprint SmartView’s WiFi Support has been disabled. 
To re-enable WiFi functions, select the Use this as my default WiFi management utility check 
box on the Client tab of the Settings window (see page 89).

● Profiles – Display the Network Profiles window (see page 66). This window is used to 
create and edit network profiles and to set their priority.

● Sprint WiFi Login – Open the Username and Password Logon window. This window 
can be used to enter a single standard user name and password combination that 
will be used as a default for all WiFi connections. See page 21.

● WiFi Info – Open the WiFi Info window. This window displays technical information 
about the WiFi network you are connected to and your current WiFi device. See “WiFi 
Network Info” on page 107.

● Lock Device – Lock and unlock your device. A check mark appears next to this item 
when your device is currently locked. (See “Locking and Unlocking Your Sprint 
Mobile Broadband Device” on page 28 for more information.)

● Mobile Info – Open the Mobile Info window. This window displays technical 
information about the mobile network you are connected to and your current Sprint 
Mobile Broadband device. See “The Mobile Info Window” on page 109.
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● WiMAX Info – Open the WiMAX Info window. This window displays technical information 
about the WiMAX network you are connected to and your current WiMAX device. See 
“The WiMAX Info Window” on page 112.

● Update Data Profile – Instruct your Sprint Mobile Broadband device to update its 
provisioning information so that it may properly use Sprint data services.

● Change Device Mode – This submenu appears when certain dual mode (3G/4G) mobile 
devices are attached. Select “CDMA” to use the device in 3G mode. Select “WiMAX” to 
use the device in 4G mode.

● Activate Device – Activate your Sprint Mobile Broadband device.

● Check for Updates Now –  Force Sprint SmartView to check for updates to its software 
and its databases immediately.

● Settings – Open the Settings window. The Settings window allows you to configure a 
number of personal preference features. This window is covered in detail in Section 6, 
“Sprint SmartView Settings” on page 84.

● Enable/Disable WiFi – Select this option to enable and disable your WiFi device. Disabling 
a device is useful when you want to prevent it from establishing connections or when you 
want to prevent it from consuming your laptop's power.

● Enable/Disable 3G – Select this option to enable and disable your 3G mobile broadband 
device. Disabling a device is useful when you want to prevent it from establishing 
connections or when you want to prevent it from consuming your laptop's power.

● Enable/Disable 4G – Select this option to enable and disable your WiMAX device. 
Disabling a device is useful when you want to prevent it from establishing connections or 
when you want to prevent it from consuming your laptop's power.

The Help Menu

Clicking Help in the menu bar of the Sprint SmartView main window opens a short menu with 
the following options:

● Help – Open Sprint SmartView’s Help system. 
● Event History Manager – Display a list of the most recent Sprint SmartView events 

(network connections, network disconnections, errors, etc.). (See “Event History Manager” 
on page 106 for more information.)

● About Sprint SmartView – Open a window displaying version information for the Sprint 
SmartView software. (See “About  Sprint SmartView” on page 115.)
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Username and Password Logon Window

Selecting Sprint WiFi Login from the Tools menu opens the Username and Password Logon 
window.

1. Enter your user name in the Username field.

2. Enter your password in the Password field.

3. Re-enter your password in the Confirm Password field.

4. Choose the Save option that best suits your needs:

� Save Nothing

� Save Username only

� Save Username and Password

5. Click OK to save your entries and close the window. (Click Cancel to discard your 
entries and close the window.)
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Section 3A

Mobile Broadband

� Manually Connecting to the Sprint Mobile Broadband Network (page 24)
� Automatic Connection Upon Device Attachment (page 25)

� Multiple Broadband Devices (page 26)

� Locking and Unlocking Your Sprint Mobile Broadband Device (page 28)
� 3G Bearer Types (page 28)

This section describes connecting to the Sprint Mobile Broadband Network.

Manually Connecting to the Sprint Mobile Broadband Network

Before you begin, you will need the following:

● A 3G or a 4G Sprint Mobile Broadband device that you will use to establish connections. 
Windows device drivers for this device must be properly installed according to the 
manufacturer’s instructions and the device must be selected in the Hardware tab of Sprint 
SmartView’s Settings window.

● A valid Sprint Mobile Broadband account
● A network profile configured to access the Sprint network. (This is created for you 

automatically when you connect a supported Sprint Mobile Broadband device.)

Follow these steps to connect to the Sprint Mobile Broadband Network:

1. If you have not already done so, connect the device that you wish to use. Sprint 
SmartView will begin searching for an available network. 

2. If you want to switch from 3G to 4G (or vice versa), click Switch to 3G (or 4G). Note that if 
you have a single device that supports both 3G and 4G connections rather than two 
separate devices, there will be a few seconds delay while the device switches modes.

3. When Sprint SmartView is ready, the connection status text on the Mobile control panel 
will display “Ready:” followed by the name of the network that has been selected. Click 
Connect to establish a connection.

Note: If you are using a GSM mobile broadband device for international roaming, clicking the arrow ( ) on 
the right side of the Connection Status Indicator opens a menu listing all GSM network profiles. You 
can establish a connection using any profile listed simply by selecting it from the menu. The default 
(“Sprint”) profile, however, should be used when connecting to any of Sprint’s roaming partners. (See 
“International Roaming (GSM)” on page 30 for more information about roaming internationally.)
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Automatic Connection Upon Device Attachment

When a device is in NDIS mode, it can be configured to establish a connection 
automatically whenever you attach it to your computer. 

1. Open the Hardware tab of the Settings window. (Click Tools > Settings > Hardware.)

2. Click Modify next to the Mobile Devices heading. The CDMA version of the Device 
Properties window appears (see page 93).

3. Select the Auto Connect when device is available check box.

Note: This feature will behave differently depending on whether RAS or NDIS is selected in the 
section below the check box. If RAS is selected, autoconnection will occur only if the Sprint 
SmartView software is running. If NDIS is selected, autoconnection will occur even if Sprint 
SmartView is not running.

4. Click OK to exit the Device Property window.

5. Click OK to exit the Settings window.

Your device should now automatically establish a connection each time you connect it to 
your computer.

Important: This is one of two autoconnect features provided by the Sprint SmartView software. This 
feature automatically establishes a connection when you attach a particular mobile 
broadband device to your computer. It will automatically connect to the highest priority 
network regardless of whether the profile for that network specifies autoconnection.

The other feature automatically establishes connections to individual networks based on the 
configuration of the corresponding network profiles. This is controlled by the Connection 
Options setting on the General page of the profile properties window. The feature is enabled 
each time you start Sprint SmartView, but can be disabled by establishing a connection 
manually. You can re-enable this feature by clicking Auto in the main window.
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Multiple Broadband Devices

If you already have a broadband device connected and a new, previously unknown broadband 
device is connected, Sprint SmartView prompts you to pick which device you want to use. 
Depending on what is selected for Mobile Devices in the Selection column of the Device List on 
the Hardware tab of the Settings window, one of two pop-up windows is displayed. For more 
information, see “The Hardware Tab” on page 90 and “The Device List” on page 92.

If Manual is selected in the Selection column for Mobile Devices, when you insert a previously 
unknown device, the following pop-up window appears:   

Select one of the options:

● Use the <New Device Name> and make it my default device to use.

● Use the <New Device Name> this one time only.

● Don’t use the <New Device Name> at this time.
Click OK after you select an option.
26        Mobile Broadband



M
ob

ile
 B

ro
ad

ba
nd
If Automatic is selected in the Selection column for Mobile Devices, when you insert a 
previously unknown device, the following pop-up window appears:   

Select one of the options:

● Use the <New Device Name> and assign it the highest priority.

● Use the <New Device Name> and assign it the lowest priority.

● Don’t use the <New Device Name> at this time.
Click OK after you have selected an option.

You can change the device priority on the Hardware tab of the Settings window.
Mobile Broadband        27



Locking and Unlocking Your Sprint Mobile Broadband Device

You can lock your Sprint Mobile Broadband device to prevent it from being used by 
unauthorized individuals. A locked device cannot be used to establish a connection until it has 
been unlocked.

Locking the Device
1. Select Lock Device from the Tools menu. The Enter Lock Code window appears. 

2. Enter the current Lock Code in the space provided. 

Note: The default lock code is the last four digits of the device’s phone number, which can be found by 
selecting Mobile Info from the Tools menu (it’s the second item under User information on 
the Device tab).

3. Click OK to lock the device.

Unlocking the Device
1. Select Lock Device from the Tools menu. (When the device is locked, this item will have a 

check mark next to it.) The Enter Lock Code window appears. 

2. Enter the current Lock Code in the space provided.

3. Click OK to unlock the device.

3G Bearer Types

The bearer types described below are available for 3G connections.

CDMA Bearer Types (Used for Domestic 3G Connections)
CDMA bearer types include the following (from fastest to slowest):

EVDO REV A
Revision A of the EVDO protocol supports download speeds of up to 3.1 megabits per second.

EVDV
EVDV (Evolution-Data/Voice) is a bearer type for 3G CDMA networks that supports downloads 
speeds of up to 3.1 megabits per second.
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EVDO
EVDO (Evolution-Data Optimized) revision 0 is a bearer type for 3G CDMA networks that 
supports download speeds of up to 2.4 megabits per second.

1xRTT
1xRTT (1 times Radio Transmission Technology) is the most basic bearer type for 3G 
CMDA networks. It is usually limited to download speeds of 144 kilobits per second. 
Because of its limited (slower) nature, it is sometimes referred to as a 2.5G technology.

QNC
QNC (Quick Net Connect) is a 2G bearer type. As one of the earliest protocols for 
transmitting digital data over CDMA networks, it is capable only of relatively slow download 
speeds of 14.4 kilobits per second.

GSM Bearer Types (Used for International Roaming)
GSM Bearer types include the following:

HSUPA and HSDPA
HSUPA (High Speed Upload Packet Access) and HSDPA (High Speed Download Packet 
Access) are the upload and download components of the HSPA protocol suite. If your 
device reports that it is using one of these, the other is almost certainly being used as well. 
These are fast 3G bearer types that directly compete with fast CDMA bearer types like 
EVDO and may eventually reach speeds comparable to 4G.

UMTS
UMTS (Universal Mobile Telecommunications System) may refer to a number of 3G 
technologies, including HSPDA and HSUPA at the faster end as well as a few other 3G 
technologies that might be slightly slower.

EDGE
EDGE  (Enhanced Data rates for GSM Evolution) is a 3G bearer type whose maximum 
download speed in the vicinity of 200 kilobits per second, depending on network 
configuration.

GPRS
GPRS (General Packet Radio Service) is a 2.5G bearer type for GSM networks. It's limited to 
a maximum download speed of around 60 or 80 kilobits per second, depending on 
network configuration.
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Section 3B

International Roaming (GSM)

� Selecting CDMA or GSM on a Dual-Mode Device (page 30)
� Switching Between a CDMA Device and a GSM Device (page 31)

� Establishing an International Roaming Connection (page 31)

� Manually Selecting a GSM Roaming Network (page 31)
� Creating a GSM Network Profile (page 34)

� International Technical Support (page 35)

This describes how you can you can connect to Sprint’s roaming partner networks around the 
world using the same simple, one-click access employed for domestic connections. 

Note: You will need a service plan that includes International Roaming.

Selecting CDMA or GSM on a Dual-Mode Device

If you have a dual-mode CDMA/GSM device, you must select the mode you want to use. This 
can be accomplished by doing either one of the following:

● Select Change Device Mode from the Tools menu.
● Select a different mode from the Select Device Mode dropdown menu in the Device 

Properties Window.

Manual Mode Switching
If neither one of the options above are available, you must change modes manually (on the 
device itself). Follow these steps:

1. Select CDMA or GSM mode according to the instructions that came with your device.

2. Force Sprint SmartView to learn the type of device you’re using. This happens 
automatically whenever you start the Sprint SmartView application. If Sprint SmartView is 
already running, you can do any one of the following:

� Connect the device to your computer (if not currently connected)

� Disconnect and reconnect your device (if already connected)

� Exit and restart the Sprint SmartView application.
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Switching Between a CDMA Device and a GSM Device

If you have both a GSM device and a CDMA device attached to your computer, you can 
select which device you would like to use by doing the following:

1. Open the Hardware tab of the Settings window. (Click Tools > Settings > Hardware.)

2. Scan down the list until you locate the Mobile Devices heading. To the right of this 
heading (in the Selection column) is a pull-down menu. Select Manual from this 
menu. (This enables manual selection of your mobile broadband device.) 

3. Select the check box next to the device you wish to use.

4. Click OK to exit the window.

Establishing an International Roaming Connection

Once you have attached a GSM mobile broadband device (or a dual-mode device in GSM 
mode), the Sprint SmartView software will search for an available roaming network and 
configure itself to connect to that network as needed. When it’s finished, the status text on 
the main window will inform you that Sprint is ready to connect, just as it does for domestic 
connections.

Click Connect on the Mobile Control Panel to establish a connection.

Manually Selecting a GSM Roaming Network

If you wish to override Sprint SmartView’s choice of a network to connect to, you can do so 
by following these steps:

1. Go to www.sprintpcs.com/common/popups/pop-gprsCarriers.html, where you’ll find 
a list of Sprint’s roaming partners that provide data services.

2. Note which carriers provide data services supported by your device in the area to 
which you are traveling.

3. Connect your GSM mobile broadband device to your computer.

4. If the device is a dual-mode device, make sure the device is in GSM mode.

5. Start the Sprint SmartView software.

6. Open the Settings window. (Click Tools > Settings.)
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7. Select the Hardware tab.
32        International Roaming (GSM)



In
te

rn
at

io
na

l R
oa

m
in

g 
(G

S
M

)
8. Scan down the list of installed devices until you find the Mobile Devices heading. Click 
Modify directly to the right of this heading. The GSM Device Property window appears.

9. Select Manual in the Network selection box.

10. Click Scan. A list of all GSM networks detected appears in the table.

11. Click to highlight the Operator name or the Operator ID of the desired operator to 
select the network you wish to connect to. (Use one of the operators you chose in 
step 21.)

Note: In some cases, the same operator may provide multiple data services, all of which look the 
same in this list (such as the “Orange” listing in the image abov e). The only way to tell these 
apart is to simply try connecting to one. If it’s not the one you want, try another. (The services 
will always appear in the same order in this window.) 

12. Click OK to exit the window.
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Creating a GSM Network Profile

Creating a GSM profile should rarely, if ever, be necessary. Whenever you connect a GSM 
device, Sprint SmartView creates a GSM network profile for you automatically. The automatically 
generated profile can be used to connect to any of Sprint’s roaming partner networks.

There are two types of manually created GSM profiles:

● Sprint Profiles are actually slightly customized profiles based on Sprint’s default GSM 
profile. As such, they inherit Sprint’s GSM connection settings, but allows you to 
customize TCP/IP settings (see page 74) and General profile settings (see page 80). At 
this time, Sprint is not aware of any specific situation in which this would be required. 
However, the capacity to create such a profile is provided in the event that Sprint’s 
Technical Support staff needs to resolve a particular connection problem by helping you 
manually alter your connection settings.

● Custom Profiles are entirely new profiles, unrelated to the Sprint GSM profile. Creating a 
custom profile will be required if a non-Sprint SIM is placed in the device.

Important: Sprint does not support the use of non-Sprint SIMs. If you choose to do so, it is entirely your 
responsibility to obtain the correct connection information from the provider of the SIM and 
enter it correctly into the Network Profile Wizard.

Follow these steps to create a GSM network profile:

1. Select Profiles from the Tools menu. The Network Profiles window will be displayed.

2. Select Add New Profile from the Settings menu. A list of network profile types appears.

3. Select Mobile and click Add. The first page of the Add Profile Wizard appears. This page 
prompts you to choose one of the two profile types.

4. Select either Sprint or Create Custom Profile and then click Next. The Mobile page of the 
New Profile Wizard appears (see page 72).

� If you selected Sprint on the previous page, the correct settings for the Mobile page 
will be pre-populated and you can’t change them here.

� If you selected Create Custom Profile, enter the correct settings for connecting to the 
desired GSM network.

5. Click Next. The IP Settings page appears (see page 74).

� The default selections in the IP Settings page are correct for most GSM networks. If, 
however, a particular network requires a specific IP address, DNS server settings, or 
both, you can specify them here.

6. Click Next. The General page appears (see page 80).

� The settings in the General page are largely determined by your preferences. For 
example, do you want to launch your browser upon a successful connection? You 
can make such choices here.

7. Click Finish.
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International Technical Support

Sprint Worldwide Customer Service is available to answer your questions 24 hours a day, 7 
days a week. Visit www.sprint.com/international and click Chat with us to talk online with an 
International Services representative; or click Email us to send an email to an International 
Services representative; or you can call the numbers below if you need assistance.

While in the United States:
� Call 1-888-226-7212, option 2.

While traveling outside the United States:
� Call +1-817-698-4199, option 3.

There is no charge for this call from your Sprint wireless device.

From a landline phone when outside the United States:
Sprint Worldwide Customer Service can be reached from a landline phone at +1-817-698-
4199, option 3. Access or connection fees may apply. The toll-free numbers below can also 
be used to contact Sprint Worldwide Customer Service in the following countries.

● Anguilla 1-888-226-7212

● Barbados 1-888-226-7212

● Cayman Islands 1-888-226-7212
● Dominica 1-888-226-7212

● France 0800-903200

● Germany 0800-80-0951
● Italy 800-787-986

● Trinidad & Tobago 1-800-201-7545

● United Kingdom 0808-234-6616 

Note: This toll-free service is available through ordinary landline phones and some public payphones. 
Additional fees may be incurred if you call this service from hotels.
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Section 3C

WiFi Networks

� Manually Connecting to a WiFi Network (page 36)
� Options for Connecting to a New Network (page 37)

� Accessing a Closed Network (page 38)

� Introduction to WiFi Encryption (page 38)
� Accessing an Encrypted Network (page 40)

� WiFi Location Finder (page 40)

This section walks you through connecting to WiFi networks, including finding WiFi locations 
and accessing encrypted, and closed networks.

Manually Connecting to a WiFi Network

Follow these steps to manually connect to a WiFi network:

1. If you have not already done so, connect your WiFi device to your computer. If your device 
is properly connected and configured, Sprint SmartView will begin searching for an 
available network. When Sprint SmartView is ready, the connection status text on the Wi-Fi 
control panel will display “Ready:” followed by the name of the network that has been 
selected.

2. If you want to connect to the network Sprint SmartView has selected, click Connect.

– or –

If you want to connect to a different network, do one of the following:

� Click the My Networks button in the upper-right corner of the interface. This displays a 
list of all networks that are currently available for connection.

� Click the arrow ( ) to the right of the WiFi connection state indicator to display a list of 
the currently defined WiFi network profiles.

Prompts
Sprint SmartView will attempt to establish a connection to the selected network. You may see 
either one or both of the following prompts during this process:

● If the network is encrypted, you will be prompted to enter an encryption key. If this is the 
case and you know the required encryption key, enter it and click OK. If you don't know 
the encryption key for an encrypted network, you must click Cancel and select a different 
network. (See “Introduction to WiFi Encryption” on page 38 for more information on 
connecting to encrypted networks.)

● When you connect to a WiFi network for the first time, Sprint SmartView may display the 
New Network Options prompt (see page 37). Using this dialog box, you can configure 
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Sprint SmartView to automatically connect to a network in the future or to prompt you 
when that network is available.

Options for Connecting to a New Network

If Prompt me before saving network settings is selected in the Automatic Profile Creation 
Settings window (see “Automatic Profile Creation Settings” on page 69), you will see the 
dialog pictured below whenever you connect to a new WiFi network for the first time. The 
option selected specifies the type of profile that Sprint SmartView will create for this network. 
By creating a profile automatically, Sprint SmartView makes it easier for you to connect to 
the same network in the future.

You must choose one the following options:

Automatically connect to network in future
If you select this option, the profile created will specify that Sprint SmartView should 
automatically establish a connection to this network whenever it is detected.

Note: When multiple networks that have been configured for autoconnection are detected, Sprint 
SmartView will choose which network to connect to based on the ranking of profiles in the Network 
Profiles window. (See “Network Profile Priority” on page 66 for more information.)

Prompt me before connecting to this network
If you select this option, the profile created will specify that Sprint SmartView should offer to 
connect to this network whenever this network is detected.

Save settings for manual connections
If you select this option, the profile created will save the settings you used to connect to this 
network. This allows the Sprint SmartView to automate the details of establishing a 
connection to this network. However, you must still initiate connections to this network 
manually by selecting the network and then clicking Connect.
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Do not save settings
If you select this option, you can connect to the network this time, but no settings will be saved 
and no profile created.   

Accessing a Closed Network

To access a closed network with Sprint SmartView, you must set up a network profile for that 
network. Follow these steps:

1. Select Profiles from the Tools menu. The Network Profiles window will be displayed.

2. Select Add New Profile from the Settings menu. A list of network profile types appears.

3. Select WiFi.

4. Click Add. The first page of properties for the new profile appears.

5. Enter the name of the network you want to add in the SSID field. The network name is 
case-sensitive and must be entered exactly as provided by the network administrator.

6. Check This is a non-broadcasted network (Closed) to identify this as a closed network.

7. Complete the remaining fields on this page as instructed by the network administrator.

8. Click Next to continue to the General page.

9. Configure the fields on the General page as desired.

10. Click Finish to exit.

Introduction to WiFi Encryption

Unlike a wired local network, a wireless network cannot easily be protected from potential 
intruders by physical barriers such as walls. Since radio signals travel through physical objects, 
a potential intruder merely need listen with the right equipment to see the traffic traveling across 
a wireless network. For this reason, public wireless networks often employ encryption to protect 
their users.

To access an encrypted network you will need the Encryption Key used by the network you 
wish to access. 

Encryption Keys
An encryption key is a code key used to encrypt data exchanged between an encrypted 
network and Sprint SmartView. You cannot exchange data with an encrypted network without 
having the appropriate encryption key.

There are two ways to obtain an encryption key:

● Obtain a key from the administrator of the WiFi network you are trying to access.

● Configure 802.1x Authentication according to the instructions of the network's 
administrator. A key will be provided automatically as part of the login process.
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802.1x Authentication
802.1x is a protocol that specifies the method Sprint SmartView will use to obtain an 
encryption key during the WiFi login process. It is really just a standard framework that 
specifies a second protocol, called an “EAP Type” (Extended Access Protocol), to 
accomplish most of its work. Therefore, when attempting to access a network that requires 
802.1x Authentication, you will need to correctly specify the EAP used and configure the 
options for that EAP. Consult the administrator of the WiFi network you are trying to access 
for the correct settings.

Because it requires a certain amount of infrastructure, 802.1x is typically used in office and 
enterprise environments.

What Does “PSK” Stand For?
PSK stands for “Pre-Shared Key.” it simply means that your encryption key has to be 
entered manually rather than obtained automatically using 802.1x. Because of their 
simplicity, PSK methods are the typical choice for home and small office environments.

Wired Equivalent Privacy (WEP)
WEP was the standard encryption technology that was used in the early days of WiFi 
networks. More secure methods, such as WPA have since emerged, but WEP remains an 
extremely popular choice for encrypted networks. There are two variants of WEP:

● WEP Open: This is by far the most commonly used version of WEP. Networks that use 
this variant don’t bother to verify that you have the correct encryption key before 
allowing you to connect. After all, if you don't have the connect encryption key, you 
won’t be able to communicate with the network anyway.

● WEP Shared: This variant forces you to prove you have the correct encryption key 
before it allows you to connect. It does this by sending out some sample text for 
Sprint SmartView to encrypt. If the result that the network gets back is what it 
expected, then it allows you to connect. Ironically, this is somewhat less secure than 
WEP Open because the verification process used gives potential intruders a large 
hint about the contents of the encryption key.

WiFi Protected Access (WPA and WPA2)
WiFi Protected Access (WPA) is a significant improvement over WEP for both enterprises 
and home users. It was developed when an industry trade group known as the WiFi 
Alliance became concerned that the security in the existing WEP Standard was insufficient. 
They quickly issued an interim standard that would address most of their concerns while 
they developed a more complete final standard. The interim standard would become 
known as WPA, while the final standard would be termed WPA2.

Because 802.1x is a required component of WPA, both WPA and WPA2 provide an upgrade 
path for enterprises that allows them to preserve existing investments in 802.1x/EAP 
Authentication capabilities. In addition, home users can take advantage of a Pre-Shared Key 
mode in WPA and WPA2, which allows the encryption and network protection capabilities to 
function on a home network as well.

To use WPA, you will need a WPA-compliant WiFi device.
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What are TKIP and AES?
Temporal Key Integrity Protocol (TKIP) and Advanced Encryption Standard (AES) are different 
encryption protocols that can be used with WPA. TKIP is the method that was called for in the 
original WPA Specification. AES, which is even more secure, was added as an alternate method 
to later versions of the specification. So, if the network uses WPA, but doesn't specify which of 
these it uses, TKIP is the most likely of these to be supported by the network.

Accessing an Encrypted Network

The steps required to connect to an encrypted WiFi network are the same as those required to 
connect to a non-encrypted WiFi network – until you click Connect. When you click Connect, a 
dialog will prompt you to enter a network encryption key. To proceed, you must do one of the 
following:

● Enter a network encryption key obtained from the network administrator.
● Configure 802.1x Authentication as instructed by the network administrator.

When you are finished, click Connect on the prompt dialog to proceed.

Tip: You can create a profile containing the appropriate encryption information to avoid having to manually 
having to enter an encryption key each time you connect. (See “Creating a Profile for a WiFi Network” on 
page 67 for more information.)

WiFi Location Finder

Location Finder is an application that makes it easy to find nearby WiFi Access Points that are 
provided by Sprint. Sprint SmartView automates the process of connecting to these networks to 
make establishing connections as simple as possible.

To access Location Finder:
� Select WiFi Hotspot Location Finder from the Application Launch menu. (See “Launching 

External Applications” on page 42.)

To search for Access Points:
1. In the upper-left corner of the Location Finder window, select the country in which you 

wish to search.

2. You can narrow your search to a specific area by filling in more of the fields in the left 
column. For some countries, a map will appear on the right that allows selecting a specific 
region or city by clicking on it.

3. Click Search. Location Finder will display a list of found locations organized by location 
type.

4. Select the Access Point you wish to use from the displayed options. 

Tip: Clicking on any Access Point will display a short informational message about that location

   
40        WiFi Networks



Section 4

Applications



Section 4A

The Application Launcher

� Launching External Applications (page 42)
� The App Launcher Tab (page 43)

� Adding an Application (page 44)

� Editing the Settings for a Launched Application (page 44)
� Launching an Application Automatically (page 45)

� Changing the Order in Which Applications Are Launched (page 46)

� Stopping an Application From Being Launched (page 46)
� Monitoring Launched Applications (page 47)

� The Application Configuration Window (page 48)

� The Monitor Details Window (page 49)
This section describes how you can launch external applications from Sprint SmartView and 
walks you through the proceedures necessary to use this feature.

Launching External Applications

The Sprint SmartView software has the ability to quickly launch commonly used applications.

The Application Launch menu is a drop-down list of 
applications that appears in the lower left corner of 
Sprint SmartView's main window. 

Select an application from this menu to launch the 
application. 

The following applications are listed by default:

Digital Lounge. Links you to the Sprint Digital Lounge.

WiFi Hotspot Location Finder. Opens the Location Finder. (See “WiFi Location Finder” on 
page 40 for more information.)

Coverage Maps. Opens your browser to a website containing Sprint Mobile Broadband 
Network coverage information. 

My Support. Connects to online support for your Sprint Mobile Broadband device.
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You can add additional icons  to the  tApplication Launch menu using the App Launcher tab 
in the Settings window. (See “Adding an Application” on page 44 for more information.)

The App Launcher Tab

The App Launcher tab in the Settings window is used to specify which applications should 
appear in the Application Launch menu. The settings here also control launch-related 
details such as launch delays and Sprint SmartView’s response when a launched 
application is shut down.

Opening the App Launcher Tab
� Select Tools > Settings, and then click the App Launcher tab. 

Test Connection Speed. Tests and displays your mobile broadband connection speed.

My Account. Gives you access to your Sprint account and allows you to check usage data.

Guardian Control. Directs you to a website where you can download an Internet parental 
control solution that helps parents protect their children and monitor their Internet usage.
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Adding an Application

Follow these steps to add an application to the list in the App Launcher settings tab:

1. On the App Launcher tab, click Add. The Application Configuration window appears (see 
page 48).

2. Enter the name of the application that you are adding in the Profile Name field. The name 
entered here will be displayed in the App Launcher tab.

3. Click Browse next to the box marked File.

4. Select the file you wish to add to the list and then click OK.

5. If the application requires any additional parameters to be entered on the command line 
when it is launched, you can enter them in the Parameters field.

6. If you want to use an icon other than the application’s default icon, click Browse next to the 
box marked Icon. You may select either an icon (.ico) file or an executable (.exe) file. When 
you are finished selecting the file, click OK to return to the Application Configuration 
window.

Note: Executable files may contain multiple icons. By default, Sprint SmartView will select the 
application's primary icon. Ordinarily, this means that you don’t have to change the value in 
the Icon Index field. However, if you choose a different icon file in step 6 and that file is an 
executable (.exe) file, you must enter the index of the icon you wish to use. For example, if you 
want to use the first icon in the file, enter the number “1.”

7. Click OK.

Editing the Settings for a Launched Application

The parameters used to launch an application are found in two locations: the Application 
Configuration window and the Monitor Details window.

To change settings in the Application Configuration window:
1. In the App Launcher tab of the Settings window (click Tools > Settings > App Launcher), 

select the application you wish to edit.

2. Click Edit. The Application Configuration window appears.

3. Make any desired changes. (See “The Application Configuration Window” on page 48.)

4. Click OK when you are finished.

To change settings in the Monitor Details window:
1. In the App Launcher tab, click the Modify button next to the application you wish to edit. 

The Monitor Details window appears.

2. Make any desired changes. (See “The Monitor Details Window” on page 49.)
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3. Click OK when you are finished.

Note: You cannot edit the settings for the applications added to this list by Sprint.

Launching an Application Automatically

Applications can be automatically launched when you connect to particular network 
profiles. Follow these steps to configure automatic application launching:

1. Ensure that the application you wish to launch appears in the list on the App Launcher 
settings tab. (See “Adding an Application” on page 44.)

2. In the App Launcher tab, click the Modify button next to the application that you wish to 
autolaunch. The Monitor Details window appears (see page 49).

3. If you want to be prompted before the application is launched automatically, select 
Prompt in the Launch options box. Otherwise, select Auto.

4. If you don’t want the application to launch immediately upon making a connection, 
enter a time delay (in seconds) in the Launch Delay field. 

Note: A time delay is necessary only if the application is not functioning correctly because it is 
being launched too quickly after a connection is established. Applications that must run over 
a VPN connection are the most likely to require such a delay because VPN client software 
may take some time to launch and log into a VPN.

5. Click OK to exit the Monitor Details window.

6. Click OK to exit the Settings window.

7. Select Tools > Profiles from the menu bar in the main window.

8. Select the profile with which you wish to launch the applications you specified earlier.

9. Click Edit. The Profile Properties window appears.

10. On the General tab, check Enable Application Launcher.

11. Click OK to exit the Profile Properties window.

Special Cases
Internet Explorer and VPN client software are special cases. Although you can add either 
Internet Explorer or a VPN client to the list of launched applications here, it is not the easiest 
or the most flexible way to launch these applications.

● Each network profile has a dedicated setting that specifies whether Internet Explorer 
should be launched upon successful connection. (See “Profile Properties: General” 
on page 80 for more information.)

● Sprint SmartView includes a dedicated interface for configuring and launching VPN 
clients. You must use this interface if you wish to take advantage of the enhanced 
VPN functions provided by the Sprint SmartView software. (See “Automatically 
Launching a VPN Connection” on page 64 for more information.)
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Changing the Order in Which Applications Are Launched

The order in which applications are launched is controlled by the amount of launch delay 
specified in the Monitor Details window. Applications with a greater delay will be launched later 
than applications with a smaller delay. Follow these steps to change the launch delay:

1. In the App Launcher tab, click the Modify button next to the application whose launch 
order you wish to change. The Monitor Details window appears. (See “The Monitor Details 
Window” on page 49.)

2. Increase or decrease the Launch Delay to make the application launch later or sooner 
than other applications. 

Note: If Launch Delay is already set to 0 and you want this application to launch sooner than other 
applications, it is necessary to increase the Launch Delay setting of the other applications.

3. Click OK to exit the Monitor Details window.

Stopping an Application From Being Launched

Do one of the following to prevent an application from launching automatically when you 
connect to an associated network profile:

● Remove the application from the list displayed in the App Launcher tab of the Settings 
window. To do this, select the application you want to remove and then click Remove. 
Note that this also removes the application from the Application Launch menu.

● Configure the application for manual launch only by clicking the Modify button 
corresponding to the application on the App Launcher tab and then selecting Manual in 
the Launch Options list.

● Prevent all applications from being launched with a particular network profile by clearing 
the Enable Application Launcher check box on the General tab of the Profile Properties 
window.

Note: All of these options are available for applications that you have added. However, only the last option is 
available for applications Sprint has added to the App Launcher tab.
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Monitoring Launched Applications

Sprint SmartView can be configured to respond when one of the applications listed in the 
App Launcher settings tab is shut down, for example, by shutting down your connection or 
by restarting the application. 

Follow these steps to enable the monitoring of a specific application:

1. Ensure that the application you wish to monitor appears in the list in the App Launcher 
settings tab. (See “Adding an Application” on page 44.)

2. In the App Launcher tab, click the Modify button next to the application that you wish to 
launch automatically. The Monitor Details window appears. (See “The Monitor Details 
Window” on page 49.)

3. In the Monitor Action list, select what Sprint SmartView should do if the application 
shuts down. Possibilities include:

� Manual (take no action).

� Prompt you to select an appropriate response.

� Restart the application that was shut down.

� Disconnect from your current wireless connection.

4. Click OK to return to the App Launcher tab.
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The Application Configuration Window

This window allows you to select an application to be added to the list of launched applications 
in the App Launcher settings tab or to edit the settings Sprint SmartView uses to launch that 
application. 

Profile Name
This is the name that will be displayed for this application in the App Launcher tab of the 
Settings window.

File / Browse
To select the application to be launched, do one of the following:

● Click Browse, locate the file you want to launch, and then click OK.
● Type the complete path and filename of the file you wish to launch in the File field.

Note: Specifying a file automatically fills in the Icon Index and Icon fields below.

Parameters
If you wish to specify any command line parameters to use when launching this file, you may 
enter them in this field. Most applications do not require such parameters to launch, but some 
may use them to configure particular options. See the documentation for the application you 
wish to launch for more information about command line parameters that the application 
supports.

Test
Click this button if you wish to verify that the application launches correctly. Sprint SmartView 
will attempt to launch the software with the configuration you have specified.
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Icon Index
Since executable (.exe) files can contain multiple icons, this field can be used to specify 
which icon in such a file to use. 

Note: This field is automatically filled in when an executable file is selected above.

Toolbar Position
This field not currently used by the Sprint SmartView software.

Icon / Browse
By default, Sprint SmartView will use the primary icon from the executable file selected 
above. 
To select an icon from a different file, do one of the following:

● Click Browse, locate the file that contains the icon you wish to use, and then click OK.

● Type the complete path and filename of the file containing the icon you wish to use in 
the Icon field.

Toolbar Tooltip
The field is not currently used by the Sprint SmartView software.

The Monitor Details Window

The Monitor Details window allows you to specify whether a given application listed in the 
App Launcher tab will be launched automatically when you connect and what actions Sprint 
SmartView should take when that application is shut down.

Launch options
This setting determines whether an application should be launched automatically when you 
successfully establish a connection using certain profiles. (See “Launching an Application 
Automatically” on page 45 for more information.)

● Auto – The application will be launched automatically (without prompting you).
● Prompt – Sprint SmartView will prompt you before launching the application.
● Manual – The application will not be launched automatically.
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Launch Delay (sec)
If Launch options is set to Auto, Sprint SmartView will wait the number of seconds specified 
here before launching the application. The delay period begins immediately after a successful 
connection is made. 

Note: In most cases, a delay is not necessary. It is only needed when launching an application too quickly 
causes a problem.

Monitor Application
Select this check box if you want Sprint SmartView to monitor this application and to take a 
specified action when the application is shut down.

Monitor Action
If Monitor Action is checked, this field specifies what Sprint SmartView should do when it 
detects that this application has been shut down.

● Manual – Sprint SmartView will not respond to the application being shut down.

● Prompt – Sprint SmartView will prompt you for a course of action.

● Restart – Sprint SmartView will restart the application.
● Disconnect – Sprint SmartView will shut down your current connection.

Monitor Cycle (sec)
Determines how often Sprint SmartView should check to see if the application is still running. 
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Section 4B

Using GPS

� Requirements for GPS Service (page 51)
� Mobile-Originated vs. Network-Originated GPS (page 52)

� Enabling and Disabling GPS (page 53)

� The GPS Search Menu (page 54)
� The GPS Applications Menu (page 55)

� GPS Data Fields (page 55)

� GPS Applications Window (page 56)
� Working With Third-Party GPS Applications (page 57)

Requirements for GPS Service

The following conditions must be met to access GPS services with the Sprint SmartView 
software:

● You must be using a Sprint Mobile Broadband device containing a GPS receiver. 
GPS receivers in mobile phones are not currently supported.

● You must have a valid Sprint Mobile Broadband subscription.

● You must agree to the privacy agreements that appear when you attempt to access 
Sprint SmartView’s GPS functions.

● GPS must be enabled. (See “Enabling and Disabling GPS” on page 53 for more 
information.)

● Some additional configuration may be required in order to use third-party GPS 
software. (See “Working With Third-Party GPS Applications” on page 57 for more 
information.)

However, GPS services will not be available if any of the following are true:

● Your device only supports CDMA EVDO mode.

● You are using a dual-mode CDMA/WiMAX device and that device is currently 
connected to a WiMAX network.

● You are currently indoors. GPS receivers must be able to lock onto the global 
positioning satellites to accurately determine position. The number of obstructions 
present indoors often makes accurate position determination impossible. 
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Mobile-Originated vs. Network-Originated GPS

GPS queries can be originated either by your device or by the Sprint network.

● Mobile-originated queries are generated when you use software on your computer or on 
your device to retrieve location data. Applications in this class include any mapping and 
navigation software that can be installed on your computer. 

● Network-originated queries are generated when the Sprint network needs to locate your 
device. This is the method that is used when your device needs to be located in an 
emergency. However, it is also possible for applications to use this method to obtain the 
position of your device from the Sprint location server.

Privacy Concerns for Network-Originated GPS
Since network-originated queries are initiated by the network rather than by you, no additional 
configuration is needed to use this feature. However, if you are not comfortable with Sprint being 
able to track your device’s location, you can enable “privacy mode” to block network-originated 
GPS queries. Under privacy mode, both mobile-originated and network-originated queries are 
disabled. So, when you are not actively using GPS, you can disable it if you wish to avoid the 
possibility of being tracked. (See “Enabling and Disabling GPS” on page 53 for instructions.)

At any given time, you can determine whether privacy mode is on by looking at the Privacy 
Indicator icon near the upper right corner of the main user interface. It has three states:

Privacy on/GPS disabled. You cannot be tracked using GPS, nor can you use other 
GPS functions.

Privacy off/GPS enabled. GPS is currently enabled and the network can use it to 
locate you. 

(no icon)

No GPS device (Privacy on). The privacy icon does not appear if no GPS-capable 
mobile broadband device is currently attached to your computer. It also does not 
appear if you have checked Disable GPS on Device on the Location/GPS settings 
tab. In either of these cases, GPS is disabled for the entire Sprint SmartView 
application.
52        Using GPS



U
si

ng
 G

P
S

Mobile-Originated Service Modes
There are two modes of mobile-originated GPS service. Some devices support only one 
mode; others support both.

● Basic – the default mode of all GPS-capable mobile broadband devices. In this 
mode, the Sprint network helps the device to obtain its initial fix on GPS satellites. 
This has the effect of allowing the device to obtain its initial position reading 
somewhat faster than in stand-alone mode. However, this mode requires access to 
the Sprint network. When the Sprint network is not available, Sprint SmartView will 
offer to switch to standalone mode (if your device supports it).

● Autonomous/Standalone – in this mode, your mobile broadband device acts as a 
completely standalone GPS receiver. It does not query the Sprint network for location 
data. This has the advantage of being available when you are roaming, but it may 
take longer to obtain initial position data from the device.

Note: If your device supports both modes, you can specify which mode will be used by default using the 
GPS Mode setting on the Location/GPS tab of the Settings window.

Enabling and Disabling GPS

Using the GPS receiver in your mobile broadband device requires that you enable GPS in 
the Sprint SmartView application. Using external third-party GPS applications requires that 
you enable NMEA.

Enabling GPS
GPS will be enabled automatically if you do any of the following:

● Initiate a search using the GPS Search menu

● Attempt to launch an application using the GPS Applications menu

● Enable NMEA

Enabling NMEA
When NMEA is disabled, the GPS icon will appear gray or yellow as shown below:

(gray)

GPS and NMEA disabled. In this state, GPS data is not received by the Sprint 
SmartView application.

(yellow)

GPS enabled/NMEA disabled. In this state, GPS data is received by the Sprint 
SmartView application, but the received data is not shared with third-party GPS 
applications.
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(white)

GPS and NMEA enabled. In this state, GPS data is received by the Sprint SmartView 
application and data is shared with third-party GPS applications.

Click this icon to enable NMEA. The icon will turn white. Click again to disable NMEA. 

Additionally, NMEA will be enabled automatically when you launch an application using the 
GPS Applications Menu.

Shutting Off GPS Entirely
If you wish to disable GPS entirely, check the Disable GPS on Device field on the Location/GPS 
settings tab. (See “Disable GPS on Device” on page 98.) This disables GPS and removes all 
GPS-related items from Sprint SmartView’s user interface.

The GPS Search Menu 

If your device contains a GPS receiver, you can use the GPS Search menu to search for the 
nearest restaurants, gas stations, and other amenities. This pull-down menu appears on the 
bottom of the main window, just to the right of the Application Launch menu.

To perform a search:

1. Specify the type of location to search for by doing one of the following:

� Pull down the menu to select one of the predefined searches (see below).

� Type what you are looking for in the field at the top of the menu. (Sprint SmartView will 
search for the nearest examples of whatever you typed and then add this search to 
the menu.)

2. Click Find.

Note: As custom searches are added, the list can potentially become quite long. Items can be removed 
from the list using the window that appears when you click Configure GPS Applications in the 
Location/GPS tab of the settings window.

Predefined Searches
The following search items are predefined by Sprint:

● Sprint Stores

● Local Restaurants
● Local Banks

● Local Hotels

● Local Gas Stations
● Local Coffee Houses

Note: The Sprint SmartView software does not currently support GPS receivers on wireless phones.
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The GPS Applications Menu 

Clicking the arrow to the right of the icon opens the GPS Applications menu. This 
menu can be used to quickly launch applications that require GPS input (such as mapping 
utilities and other location-based applications).

By default, there are no applications listed here, but you can add GPS applications to the 
menu in the GPS Applications window. (See “Adding a GPS Application to the GPS 
Applications Window” on page 58 for more information.)

GPS Data Fields

The following data fields appear on the Location/GPS tab of the Settings window and in the 
menu that appears when you hover over the GPS icon in the main window:

● Number of Satellites – The number of satellites your GPS receiver has acquired. At 
least three are required to provide latitude and longitude and four are required to 
provide an altitude. Additional satellites provide greater accuracy (seven or more is 
considered excellent).

● HEPE – Horizontal Estimated Position Error. This is a measure of the accuracy of your 
calculated position. So, if the HEPE is 43 feet, you could be as much as 43 feet from 
the coordinates indicated by your device’s GPS receiver.

● Latitude – Your current latitude, expressed in degrees and rounded to four decimal 
places. Positive numbers are used for locations north of the equator. Negative 
numbers are used for locations south of the equator. Zero is the equator itself.

● Longitude – Your current longitude, expressed in degrees and rounded to four 
decimal places. Positive numbers indicate locations east of the Prime Meridian 
(which passes through Greenwich, England). Negative numbers indicate locations 
west of the Prime Meridian.

● Elevation – Your current altitude above Sea Level (in feet). Note that because of the 
inherent difficultly in determining altitude via GPS, the margin of error for altitude may 
be larger than the HEPE (the margin of error for latitude and longitude).

● Speed – The estimated speed at which you are moving.

● Heading – The approximate direction in which you are moving. Compass headings 
range from 0 degrees (due north) to 360 degrees, with 90 being due east, 180 due 
south, and 270 degrees due west.

● GPS Port/NMEA Port – The next available NMEA Port available for use by a GPS 
application. Some applications require you to enter this port number.
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GPS Applications Window

This window is reached by clicking Configure GPS Applications on the Location/GPS tab of the 
Settings window. It is nearly identical to the App Launcher settings tab described on page 43, 
and configuring applications differs very little from one to the other. However the following 
differences should be noted:

● The applications configured here are assumed to be GPS-aware (for example, mapping 
applications). Such applications appear in the GPS Applications menu rather than the 
Application Launch menu.

● Unlike the App Launcher settings tab, the list here also contains search items. These 
appear in the GPS Search menu. Note, however, that you cannot add new search items 
in this window. Search items can be added by typing them into the field at the top of the 
GPS Search menu.

● GPS applications must be assigned an NMEA port (see “GPS/NMEA COM Ports” on 
page 57). Sprint SmartView uses this port to send the data generated by your GPS 
receiver to the application.

● As a result of the above differences, the procedure to add a new GPS applications differs 
somewhat from the process described in “Adding an Application” on page 44. See 
“Adding a GPS Application to the GPS Applications Window” on page 58 for the GPS-
specific version of this procedure.
56        Using GPS



U
si

ng
 G

P
S

Working With Third-Party GPS Applications

The Sprint SmartView software allows you to share the GPS data generated by your mobile 
broadband device with third-party GPS applications. Typically, such applications assume 
that the GPS receiver is attached to a communications (COM) port on your computer and 
that the data it outputs is formatted according to the NMEA standard for GPS data. The GPS 
receiver on your device, however, is attached to your computer through an entirely different 
kind of port. To remedy this, the Sprint SmartView software creates three virtual COM ports 
to which it can forward NMEA GPS data. 

To share GPS data with a third-party application, you must do all of the following:

● Enable GPS and NMEA. (See “Enabling and Disabling GPS” on page 53 for more 
information.)

● Identify the GPS/NMEA ports created by the Sprint SmartView software. (See “GPS/
NMEA COM Ports” below.)

● Configure your third-party software to use one of Sprint SmartView’s three GPS/
NMEA ports (consult the documentation that came with the third-party application).

● Add the application to the GPS Applications menu. (See “Adding a GPS Application 
to the GPS Applications Window” on page 58.) 

GPS/NMEA COM Ports
When you are configuring an application that uses GPS data, the application may ask you 
to enter the number of the COM port over which it will be receiving this data. 

Sprint SmartView provides three such ports for use by other applications. Specific ports can 
be assigned to applications when you are adding them to the GPS Applications menu. First, 
however, you must identify the three COM ports Sprint SmartView has provided. The exact 
procedure for doing this is unique to each version of Windows.

Windows XP
1. Open the Windows System Properties folder. The procedure for doing this depends 

on whether “My Computer” is on your desktop or in the first level of the Start menu. 

� If “My Computer” is on your desktop, right-click the My Computer icon and then 
select Properties from the menu that appears.

� If “My Computer” is on the first level of the Start menu, select My Computer from 
the Start menu and then click View System Information in the left column of the 
window that appears.

2. Select the Hardware tab.

3. Click Device Manager. In the Device Manager window, the three virtual ports created 
by Sprint SmartView are listed under the Ports (COM & LPT) heading.
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Windows Vista / Windows 7
1. Display the Windows System Properties folder. The procedure for doing this depends on 

whether “Computer” is on your desktop or in the first level of the Start menu. 

� If “Computer” is on your desktop, right-click the Computer icon and then select 
Properties from the menu that appears.

� If “Computer” is on the first level of the Start menu, select Computer from the Start 
menu and then click System Properties at the top of the window that appears.

2. Click the Device Manager link in the left column. In the Device Manager window, the three 
virtual ports created by Sprint SmartView are listed under the Ports (COM & LPT) heading.

Adding a GPS Application to the GPS Applications Window
Follow these steps to add an application to the list in the GPS Applications window. 

1. In the Location/GPS tab of the settings window, click Configure GPS Applications. The GPS 
Applications window appears.

2. Click Add. The Application Configuration window appears.

3. In the Profile Name field, enter the name of the application that you are adding. The name 
entered here will be displayed in the Applications window.

4. Click Browse (next to the box marked File).

5. Select the file you wish to add to the list and then click OK.

6. If the application you are adding supports specifying the NMEA COM port on the 
command line, you can enter it in the Parameters field. This is an alternative to specifying 
the port within the launched application itself. Once you have determined the format that 
the application uses for the NMEA command line parameter, there are two ways of 
specifying the actual port number:

� Enter a port number directly (for example COM33). Note, however, if another GPS 
application is already using this port when you open this application, this application 
will not be able to receive data. Be careful not to assign the same number to two GPS 
applications that are likely to be open at the same time.

� Instruct Sprint SmartView to assign the application the next available port each time 
the application is opened. To do this, use $NMEAPORT in place of the actual port 
number.

Note: The Parameters field also allows you to specify additional command line parameters to be 
used when launching the application. However, these additional parameters must be 
enclosed in parentheses.

7. Click OK.

Note: Applications added using this procedure will appear in the GPS Applications menu rather than the 
GPS Search menu. If you wish to add an item to the GPS Search menu, just type the text you want to 
search for into the field at the top of the menu itself.
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Application Configuration Example: Microsoft Streets & Trips 2008
1. Identify the GPS/NMEA ports that have been added to your system by the Sprint 

SmartView software. (See page 57 for instructions specific to each version of 
Windows.) 

2. Open Microsoft Streets & Trips 2008.

3. From the Streets and Trips menu bar, select Tools > GPS > Configure GPS Receiver. 
The GPS Receiver Settings window appears as shown below.

4. In the list of ports at the bottom of the page, select one of the three ports identified in 
step 1. If possible, choose a port that you have not yet assigned to another GPS 
application. (Each port may be used by only one application at a time.)

Tip: If the Sprint SmartView software is currently open and NMEA is currently enabled, you can verify 
that the selected port is functioning properly by clicking Scan. “GPS device found” should appear
next to all three of the ports identified in step 1.

5. Click OK. You may exit the Streets & Trips application now, if desired.

6. In Sprint SmartView, select Settings from the Tools menu.

7. Select the Location/GPS tab.

8. Click Configure GPS Applications. The GPS Applications Window appears.
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9. Click Add. The Application Configuration window appears.

10. In the Profile Name field, type “Microsoft Streets & Trips 2008.”

11. Enter the location of the Streets & Trips program file (streets.exe) in the File field. If you 
installed Streets & Trips in the default location, it will be at C:\Program Files\Microsoft 
Streets & Trips\streets.exe.

– or – 

Click Browse to browse for the file on your hard drive. When you have found the file, select 
it and click OK.

12. Streets & Trips does NOT support passing the NMEA port number on the command line. 
So, in this case, the Parameters field should be left blank.

13. Click OK.

You should now be able to launch Streets & Trips by selecting “Microsoft Streets & Trips 2008” 
from the GPS Applications menu. 
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Section 5A

Virtual Private Networks

� What is a Virtual Private Network? (page 62)
� Supported Clients (page 62)

� Configuring a VPN Connection (page 63)

� Automatically Launching a VPN Connection (page 64)
This section walks you through configuring a VPN network, discusses the supported VPN 
clients and shows you how to automatically lauch a VPN connection with Sprint SmartView.

What is a Virtual Private Network?

A Virtual Private Network (VPN) is a private network that can be accessed over a public 
backbone network (like the Internet) without compromising the privacy of the VPN. Typically, 
VPNs maintain their privacy by forming secure (encrypted) “tunnels” directly to users who 
access them. For example, a company might set up a VPN for its employees to access their 
corporate network securely when they are away from the office.

The software responsible for forming the tunnel with the private network is called a VPN client. 
Because the VPN client and the private network exchange data in an encrypted format, no one 
on the public network over which this information passes can access it.

Supported Clients

Although Sprint SmartView is not a VPN client itself, it can automate the launching of VPN client 
software when needed. Sprint SmartView has been tested with the following VPN clients and 
even automates certain tasks for these clients:

● Microsoft

● Cisco

● Nortel
● Checkpoint

● NetMotion

Sprint SmartView can also launch other VPN clients, but may require more manual 
configuration to do so.
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Configuring a VPN Connection

As with any other secure network, accessing a VPN requires some security-related 
configuration. Perform these steps:

1. Consult the administrator of the VPN you wish to access. The administrator will 
provide you with VPN client software and instructions for establishing VPN 
connections.

2. If the VPN client software is not already installed on your system, install it now. 
(Microsoft's VPN client is pre-installed on most versions of Windows.)

3. Follow your administrator’s instructions for setting up a VPN Login Profile.

4. Access the VPN tab by selecting the Settings option in the Tools menu and then 
clicking the VPN tab. (Click Tools > Settings > VPN.)

5. If the VPN client software you are using is supported by Sprint SmartView, select Use 
existing VPN profile. Then, specify the client software and the Login Profile that you 
want to use.

If the VPN client software you are using is NOT supported by Sprint SmartView, select 
Use third party VPN client. Then, click Browse to specify the location of the client 
software that you are using.

6. Click OK to exit the Settings window.

Once VPN settings have been configured, there are two ways to start a VPN connection.

● Automatically start a VPN session upon connection by configuring a Network Profile 
to do so.

● Manually launch the VPN client by clicking the VPN indicator (button that displays a 
padlock icon) in Sprint SmartView’s main window.
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Automatically Launching a VPN Connection

You can configure a network profile to automatically launch the VPN client and log into a VPN 
once the connection to the public network is established. Follow these steps:

1. If you have not already done so, configure the connection settings for the VPN you wish to 
connect to. (See “Configuring a VPN Connection” on page 63.)

2. Open the Network Profiles window. (Click Tools > Profiles.)

3. In the left pane, select the profile for which you want to automate VPN connections.

4. Click Edit. The Edit Profile window for the selected profile appears.

5. If the General tab is not already selected, select it now.

6. Select the Auto Launch check box.

7. Click OK to exit.

Tip: If you want the VPN client to be launched automatically with all (or most) of the new profiles you create, 
consider selecting the Auto Launch check box on the VPN tab of the Settings window. This 
configures the default behavior of all newly created profiles.
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Section 5B

Network Profiles

� What is a Network Profile? (page 65)
� The Network Profiles Window (page 66)

� Network Profile Priority (page 66)

� Creating a Profile for a WiFi Network (page 67)
� Automatic Profile Creation Settings (page 69)

� Editing a Network Profile (page 70)

� Deleting a Network Profile (page 70)
� Profile Properties: WiFi (page 71)

� Profile Properties: Mobile (page 72)

� Profile Properties: Add Mobile Profile (page 73)
� Profile Properties: IP Settings (page 74)

� Profile Properties: General (page 80)

This section describes network profiles and walks you through creating, editing, and 
deleting network profiles.

What is a Network Profile?

A network profile is a saved configuration for connecting to a particular network. Some 
profiles, such as the profile used to establish a Sprint Mobile Broadband connection, are 
predefined. Additional network profiles for other types of connections can be created in the 
Network Profiles window.

Network profiles have the following advantages:

● You can configure Sprint SmartView to automatically connect to a network profile 
whenever the associated network is available.

● If the last network you connected to is not available, the Sprint SmartView software 
uses the priorities of all defined network profiles to select a network to connect to, 
regardless of whether it is in automatic or manual connection mode. In manual 
mode, the selected network is presented as the default for manual connection. This 
allows the same easy, one click connection to an alternate network.

● You can automate steps in the connection process, such as entering an encryption 
key or logging into a VPN, so that you don't have to perform these actions each time 
you connect.

Moreover, you must have a profile to connect to:

● Closed WiFi networks. (See “Accessing a Closed Network” on page 38.)

● A mobile broadband network. (Sprint SmartView creates a profile for you 
automatically when you connect a Sprint Mobile Broadband Device.)
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● A WiMAX network. (An appropriate profile is created for you when you install the Sprint 
SmartView software.)

The Network Profiles Window

Network profiles can be added and configured in the Network Profiles window. To access the 
Network Profiles window, select Profiles from the Tools menu.   

Network Profile Priority

In the Network Profiles window, profiles are listed in order of priority. When selecting a network 
to connect to, Sprint SmartView will go down the list from top to bottom, selecting the first 
network profile for which all of the following are true.

● The network described by the profile is available.

● A device capable of connecting to the network is connected to your computer and ready.

● The Connection Options field on the General tab in the profile's configuration is set to 
either “Automatic” or “Prompt.”

Profile priority also determines when Sprint SmartView will automatically switch from one 
network to another. If you are connected to one network and a higher priority network becomes 
available, Sprint SmartView will switch to the higher priority network.

Changing Profile Priority 
To change the priority of a specific profile, select the profile whose priority you would like to 
change. Then, click Up or Down to move the profile up or down the list.
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Creating a Profile for a WiFi Network

Perform these steps to create a WiFi network profile.

1. Select Profiles from the Tools menu. The Network Profiles window will be displayed.

2. Select Add New Profile from the Settings menu. A list of network profile types appears.

3. Select WiFi and then click Add to launch the wizard used to create WiFi network 
profles.

4. In the SSID field, enter the broadcast name of the network to which you will be 
connecting. Note that the name entered here must match the SSID (Service Set 
IDentifier) used by the network exactly.

5. If the network is a Closed network, select the This is a non-broadcasted network check 
box.

6. If the network whose profile you are configuring does not use WEP or WPA encryption, 
leave the Enable data encryption check box cleared.

–or–

If the network uses WEP or WPA encryption, select the Enable data encryption check 
box and configure the WiFi Data Encryption Settings as explained in “Configuring WiFi 
Data Encryption” on page 68.
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7. Click Next. The General page appears (see page 80).

8. Configure the settings in the General page as desired and then click Finish.

Configuring WiFi Data Encryption
1. Contact the administrator of the network you wish to access to obtain any necessary 

information such as the security method used or the encryption keys required. 

2. Select the Enable data encryption check box.

3. Select the appropriate Authentication method for this network. Supported authentication 
methods include the following:

� None: For an unencrypted network.

� WEP-OPEN (Normal Method): This is the standard WEP encryption method.

� WEP-SHARED: This variant of WEP uses an encryption key that is pre-shared between 
the parties of the connection.

� WPA (TKIP or AES): If you select this method, you will need to configure 802.1x 
Authentication using the fields in the lower half of the page.

� WPA-PSK (TKIP or AES): If you select this method, you will need to enter your 
pre-shared key in the “Network Key” fields.

� WPA2 (TKIP or AES): If you select this method, you will need to configure 802.1x 
Authentication using the fields in the lower half of the page.

� WPA2-PSK (TKIP or AES): If you select this method, you will need to enter your 
pre-shared key in the “Network Key” fields.

Note: The WPA methods listed above will only be displayed if your WiFi adapter supports WPA security.
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4. If you selected WEP-SHARED or one of the WPA or WPA2 methods that have “PSK” in 
their names, you must enter the encryption key for this network in Network key and 
Confirm network key fields.

If you selected one of the WPA or WPA2 methods that don't have “PSK” in their 
names, you must configure 802.1x Authentication. Follow these steps to enable 802.1x 
Authentication when connecting to this network:

a. Select the Enable 802.1x authentication check box.

b. Select the EAP Type from the EAP type dropdown menu.

c. Click Properties to configure the settings for the selected EAP type.
If you selected “WEP-OPEN” as the authentication method, you can either enter an 
encryption key in the Network key fields or complete the 802.1x Authentication section.

Automatic Profile Creation Settings

If you wish, Sprint SmartView can automatically create network profiles for each new WiFi 
network you successfully connect to. The setting that controls this can be found by 
selecting Automatic Profile Creation from the Settings menu in the Network Profiles window. 
Choose from the following options:

● Automatically save all networks that I connect to – Sprint SmartView will create a new 
profile for every new WiFi network you successfully connect to.

● Prompt me before saving network settings – Sprint SmartView will ask you if you want 
to create a new profile each time you successfully connect to a new network.

● Allow manual input of network settings only – Sprint SmartView will not automatically 
create network profiles.
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Editing a Network Profile

You can edit all settings for network profiles you have created yourself and all of settings for 
profiles that were created automatically for you when you connected to a WiFi network. A 
reduced set of parameters will be available for modification in profiles that were created for you 
by Sprint.

1. Select Profiles from the Tools menu. The Network Profiles window appears.

2. Select the profile you wish to edit in the left pane of the window.

3. Click Edit. A tabbed interface showing all the user-editable settings of the selected profile 
appears. Depending on the type of profile you are editing, the following tabs may be 
displayed:

� WiFi (see page 71)

� Mobile (see page 72)

� Add Mobile Profile (see page 73)

� IP Settings (see page 74)

� General (see page 80)

4. Make the desired changes.

5. Click OK when you are finished.

Deleting a Network Profile

Follow these steps to delete a profile from the Network Profiles window:

1. Select Profiles from the Tools menu. The Network Profiles window will be displayed.

2. Select the profile that you want to delete from the list in the left pane of the window.

3. Click Remove. A prompt asks if you are sure you want to delete this profile.

4. Click Yes to confirm that you want to delete the profile.

Note: You can delete any profile that you created or that was created automatically for you when you 
connected to a WiFi network successfully. You cannot delete network profiles that were created for 
you by Sprint.
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Profile Properties: WiFi

The WiFi page contains the security settings for WiFi network profiles.

● The version of this window pictured on the left below appears when creating a new 
profile. 

● The tabbed version on the right appears when editing an existing profile. 
Although the window controls vary, the actual parameters included are identical for both 
versions. 

Follow these steps to configure WiFi network security:

1. In the SSID field, enter the name broadcast by the network for which you are creating 
a profile. The name entered here must match the SSID (Service Set IDentifier) used by 
the network exactly.

2. If this is a closed network, select the This is a non-broadcasted network (closed) check 
box.

3. If the network does not use WEP or WPA encryption, leave Enable data encryption 
unchecked.

–or–

If the network does use WEP or WPA encryption, select the Enable data encryption 
check box and configure the WiFi data encryption settings. (See “Configuring WiFi 
Data Encryption” on page 68.)
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Profile Properties: Mobile

This Mobile page contains the basic settings for GSM network profiles. It is not included in any 
other profile type.

● The version of this window pictured on the left below appears when creating a new 
profile. 

● The tabbed version on the right appears when editing an existing profile

Although the window controls vary, the actual parameters included are identical for both 
versions.     

Service
The name of the network for which you are creating this profile. It is not editable.

Service Type
Select the type of service provided by this network. Most GSM networks now provide packet 
data service. So, the correct selection here would be “Packet.” A few networks, however, may 
still be using the older GSM/CSD for Data Connections. In this case, “Circuit” would be the 
correct selection. 

Note: If you have selected a network that only provides one type of service, this menu will only include the 
type that is provided by the selected network.
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Dialed Number
This is the telephone number that your device must dial in order to connect to this network. 
In most cases, the dialed number for the selected network will have been pre-entered for 
you (and will not be editable). However, if you are creating a custom profile, you must enter 
the appropriate number here. If you do not know the appropriate information for this 
network, contact the network provider.

Access Point Name
This is the name of the Wireless Access Point (WAP) that your GSM device communicates 
with when connected to this network. In most cases, the Access Point Name for the 
selected network will have been pre-entered for you (and will not be editable). However, if 
you are creating a custom profile, you must enter the appropriate number here. If you do not 
know the appropriate information for this network, contact the network provider.

Profile Properties: Add Mobile Profile

The Add Mobile Profile page displays the basic settings for CDMA mobile broadband 
network profiles such as the profile used to connect to the Sprint network domestically. It is 
not included in any other profile type.

● The window pictured below appears when editing a CDMA profile. Note, however, 
that the Add Mobile Profile page is for informational purposes only. Users cannot edit 
the settings on this page.

● Since users cannot create CDMA profiles, no other version of the Add Mobile Profile 
page will appear.
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Service
The name of the network for which you are creating this profile. It is not editable.

Service Type
The type of service provided by this network (EVDO, 1xRTT or QNC). For the Sprint network, this 
is set to Auto, which tells the Sprint SmartView software to select the fastest connection 
technology available at a given location. 

Dialed Number
This is the telephone number that your CDMA device must dial in order to connect to the Sprint 
network.

MIP Profile Number
CDMA devices store connection information internally in structures known as MIP profiles. This 
field indicates which MIP profile your CDMA device is using to establish connections to the 
Sprint network.

Profile Properties: IP Settings

The IP Settings page allows you to configure the Internet Protocol (IP) addressing to be used 
with a particular profile. It is available only for mobile broadband profiles.

● The version of this window pictured on the left below appears when creating a new 
profile. 

● The tabbed version on the right appears when editing an existing profile.
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Although the window controls vary, the actual parameters included are identical for both 
versions. 

Profile IP Address
The settings in the top group specify the IP address that your system will use when 
connected to this network. The default selection, Obtain IP address automatically, instructs 
Sprint SmartView to ask the network to assign it an appropriate address each time it 
connects. This is the correct setting for most network profiles.

However, if the network does not support automatic address assignment, you can enter 
appropriate values manually by selecting Use the following IP address. Contact the 
administrator of the network whose profile you are configuring to obtain appropriate values 
for these fields.

Profile DNS Server
The settings in the lower group specify the address of the name server that your system 
should use to translate names (for example, “Sprint.com”) to numerical addresses when 
connected to this network. The default selection, Obtain DNS server address automatically, 
instructs Sprint SmartView to ask the network to provide the address of a name server each 
time it connects. This is the correct setting for most network profiles.

However, if the network does not support automatic DNS server assignment, you can enter 
appropriate values manually by selecting Use the following DNS server address. Contact the 
administrator of the network whose profile you are configuring to obtain appropriate values 
for these fields.

Alternately, click Advanced to configure detailed settings for DNS and WINS servers.
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Advanced
Clicking Advanced opens the Advanced IP Settings window. This window allows you to 
configure advanced settings pertaining to naming services and protocols to be used with a 
particular network profile. There are three tabs in this interface:

● DNS (see page 76)

● WINS (see page 78)

● Protocols (see page 79)

Advanced IP Settings: DNS Tab
The DNS tab in the Advanced IP Settings window allows you to configure the advanced settings 
pertaining to Domain Name Server usage.

DNS server addresses, in order of use
This is a list of DNS servers that may be used. The first listed will be tried first. The second 
server listed will be used if the first is not available, etc. To add a server to the list, click Add and 
then enter the IP address for that server. If you wish to change the order in which servers are 
listed, use the arrows on the right.

Append primary and connection-specific DNS suffixes
Selecting this option specifies that when attempting to resolve an unqualified DNS name, your 
computer will send two different name resolution queries:

● The first query it sends is based on the “Domain” portion of your computer's name 
(which can be found by clicking on the System icon in the Control Panel). So, if the 
computer is attempting to resolve the name “pc21” and the Domain portion of your 
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computer's name was “mycompany.com,” the first query sent would be for 
“pc21.mycompany.com.”

● The second query sent is based on the DNS suffix entered in DNS suffix for this 
connection (see below). So, if you entered “sales.mycompany.com” in that space, 
your computer would also attempt to resolve “pc21.sales.mycompany.com.” This 
query is only sent if a DNS suffix is entered in the space provided.

The local setting is used only if the associated group policy is disabled or unspecified.

Append parent suffixes of the primary DNS suffix
Selecting this check box specifies that your computer should also send queries based on 
the parent domains in your computer’s name (up to the second level domain). For example, 
if your computer is attempting to resolve the name “pc21” and its own name includes the 
domain named “us.sales.mycompany.com,” it would query for “pc21.mycompany.com” and 
“pc21.sales.mycompany.com” in addition to the standard query for 
“pc21.us.sales.mycompany.com.”

Append these DNS suffixes (in order)
Selecting this option specifies that when attempting to resolve unqualified DNS Names, 
your computer will formulate a query based on each of the domains listed in the box 
directly below this option. For example, if your computer is attempting to resolve the name 
“pc21” and the domains “sales.mycompany.com” and “mycompany.com” appear in the list, 
your computer will query for “pc21.sales.mycompany.com” and “pc21.mycompany.com.”

The local setting is used only if the associated group policy is disabled or unspecified.

DNS suffix for this connection
If you wish to specify a DNS suffix for this connection, enter it here. 

Note: If you enter a DNS suffix here, it will override any suffix assigned dynamically by a DHCP server. The 
local setting is used only if the associated group policy is disabled or ignored.

Register this connection’s addresses in DNS
Selecting this check box specifies that the computer should attempt to dynamically register 
this connection’s IP Address (through DNS) using the full computer name specified on the 
Computer Name tab (available under System in the Windows Control Panel). The local 
setting is used only if the group policy is disabled or unspecified.

Use this connection’s DNS suffix in DNS registration
Specifies whether DNS dynamic update is used to register the IP addresses and the 
connection-specific domain name of this connection. The connection-specific domain 
name of this connection is the concatenation of the computer name (which is the first label 
of the full computer name) and the DNS suffix of this connection. The full computer name is 
specified on the Computer Name tab (available under System in the Windows Control 
Panel). If Register this connection's addresses in DNS is checked, this registration is in 
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addition to the DNS registration of the full computer name. The local setting is used only if the 
associated group policy is disabled or ignored.

Advanced IP Settings: WINS Tab
The list of WINS Servers on the WINS tab of the Advanced IP Settings window is used to resolve 
NetBIOS Names (typically used by Windows Workgroups). To add a server to the list, click Add 
and then enter the IP address of the desired server.
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Advanced IP Settings: Protocols Tab
The Protocols tab of the Advanced IP Settings window lists additional protocols that may be 
used with this connection. Select the check box for the protocols you wish to use.
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Profile Properties: General 

The General page contains settings that apply to all types of network profiles. 

● The version of this window pictured on the left below appears when creating a new 
profile. 

● The tab version on the right appears when editing an existing profile. 
Although the window controls vary, the actual parameters included are identical for both 
versions.

Note: Some of the options pictured on this page may not be available if you are editing a profile created for 
you by Sprint.

Profile name
The name entered here will be displayed in the Network Profiles window and Sprint 
SmartView’s main window.

Connection options
This setting controls what Sprint SmartView will do when it detects the network to which this 
profile applies. Select one of the following options:

● Automatic – Sprint SmartView will automatically connect to this network whenever it is 
detected.

● Prompt – Sprint SmartView will ask you whether to connect to this network each time the 
network is detected.
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● Manual – You must manually initiate connections to this network (either by using the 
controls in the main window or by selecting it in the Network Profiles window and 
then clicking Connect). Sprint SmartView will not connect to this network 
automatically.

Auto Launch
Select this check box if you would like to automatically launch the VPN client software when 
you establish a connection to this network.

Enable Application Launcher
If this check box is selected, Sprint SmartView will launch selected applications whenever it 
establishes a connection to this network. For an application to be launched in this manner, 
the following must also be true:

● The application must be listed on the App Launcher tab of the Settings window.
● The Launch Options field in the Monitor Details window must be set to either “Prompt” 

or “Auto.”

If this check box is not selected, these applications will not be launched.

Disable IE’s manual proxy settings on connect
If you normally connect to the Internet through a proxy server (this is common on corporate 
LANs), you may experience difficulty connecting to the Internet with Internet Explorer when 
you are traveling. This is because Internet Explorer is trying to connect through a proxy 
server that is on your home network rather than on the network to which you are connected.

If this is the case, you can select this check box to disable proxy server settings while you 
are connected using this profile.

Launch browser window on connect
Select this check box to automatically launch your browser each time you connect to this 
network. If you want the browser to start at a particular Web page each time you connect to 
this network, enter the address for that Web page in the Start URL field.
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Section 6A

Sprint SmartView Settings

� The Acceleration Tab (page 84)
� The App Launcher Tab (page 87)

� The Client Tab (page 88)

� The Hardware Tab (page 90)
� The Device List (page 92)

� Device Properties Window: CDMA Version (page 93)

� Device Property Window: GSM Version (page 96)
� The Location/GPS Tab (page 98)

� The Sounds Tab (page 100)

� The Updates Tab (page 101)
� The VPN Tab (page 102)

This section describes the tabs located on the Settings window. The Settings window allows 
you to configure how Sprint SmartView behaves, including how it connects to networks, the 
sounds it produces, and when it retrieves updates.

To access the Settings window:
� Select Settings in the Tools menu. (From the main window, click Tools > Settings.)

The Acceleration Tab

If you enabled data acceleration when you installed the Sprint SmartView software, the settings 
window will include an Acceleration tab. (Click Tools > Settings > Acceleration.)

When connected to a mobile broadband network that supports data acceleration, Sprint 
SmartView can employ data compression and acceleration techniques to enhance your 
connection speed. Use settings in the Acceleration tab to configure the data acceleration 
employed.

● The group of settings marked Acceleration is responsible for enabling and disabling the 
acceleration feature. 

● The group of settings marked Acceleration Level configures the amount of acceleration 
used.

Note: Data compression is in effect only when Sprint SmartView is connected to a network that supports it 
and has successfully negotiated a session with that network's data acceleration server. It is not 
currently supported on 64-bit Windows systems.
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Enabling and Disabling Acceleration
The group of settings marked Acceleration is responsible for enabling and disabling the 
acceleration feature. The following items are in this group:

Startup type 
This determines whether the data acceleration client automatically starts itself whenever a 
mobile broadband connection is established, or whether your must manually click Start to 
enable the acceleration client. The client will always detect if it cannot accelerate a 
particular session and will disable itself in such cases. Examples of this would include a 
VPN connection where the data is encrypted and cannot be optimized by the acceleration 
server in the provider network.

Start/Stop
If the startup type is set to Manual, you can click Start/Stop to enable and disable data 
acceleration.

Client
This field displays the name of the acceleration client software that has been installed to 
perform data acceleration tasks.
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Install/Uninstall
If the data acceleration client is currently installed, click Uninstall to remove it from your system. 
(This will disable acceleration entirely.)

On Windows Vista and Windows 7 systems, the uninstall option will be unavailable (grayed out) 
because of restrictions in the windows security configuration. Running the application as an 
administrator will allow access to this option. Follow these steps:

1. Close the Sprint SmartView software.

2. Right click on the Sprint SmartView icon on your computer’s desktop. A short menu 
appears.

3. Select Run As Administrator from this menu.

If the data acceleration client is not currently installed, click Install to install it.

Note: Uninstall allows the Acceleration client to be uninstalled from your laptop. This function should be 
used only if the installation and operation of the Acceleration client impacts user performance or 
conflicts with another program installed on your computer.

Status 
This indicates whether or not data acceleration is currently enabled. 

Configuring Acceleration Levels
The slider in the Acceleration Level box allows the user to control the level of performance 
optimization and to balance that against the level of quality desired in the displayed graphics. 
The higher the level of acceleration, the lower the quality of the graphic images on a web page. 
The highest acceleration setting disables receipt of all graphic images on Web pages. The 
sample images to the right of this control show the typical graphical quality of each setting.

Click Default in this area to return to the default acceleration levels. 
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The App Launcher Tab

 Applications listed on this tab will appear in the Application Launch menu. (See 
“Launching External Applications” on page 42.) In addition to adding and removing 
applications from the list, you can specify whether each application will be automatically 
launched when you connect and whether you want to automatically disconnect when a 
particular application is shut down.

To access the App Launcher tab, click Tools > Settings > App Launcher.  

For more detailed information about the App Launcher, see “The Application Launcher” on 
page 42.
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The Client Tab

The Client tab contains general settings for the Sprint SmartView software. (Click Tools > 
Settings > Client.) 

User interface is always on top
When this check box is selected, Sprint SmartView will always appear on top of other 
application windows.

Enable Splash screen
If this check box is selected, Sprint SmartView displays a splash screen while it starts up. 

Automatically run this application on machine startup
When this check box is selected, Sprint SmartView will be launched automatically each time 
you start your computer.
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Display Connection Timer
When this check box is selected (default), a timer will be displayed in the main window, 
showing how long the current connection has been established. 

Use this as my default Wi-Fi management utility
When this check box is cleared, WiFi is disabled and does not appear in Sprint SmartView's 
user interface. This is useful if you have another WiFi management utility that you would 
rather use instead of Sprint SmartView. 

Start in System tray
This setting works with the “Automatically run this application on machine startup” setting. 
When the “Automatically run this application on machine startup” check box is selected 
and this check box is selected, Sprint SmartView will automatically start minimized to the 
System tray each time you start your computer. If the “Automatically run this application on 
machine startup" check box is cleared, this setting does nothing.

Transparency
This menu allows you to increase the transparency of Sprint SmartView’s main window.

Zoom
This menu lets you stretch the main user interface up to twice its default size.

Reset all warning messages
By clicking Reset, you can restore all warning messages that you may have disabled to 
their default display settings.
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The Hardware Tab

The Hardware tab is used to configure hardware-related settings for establishing a connection. 
(Click Tools > Settings > Hardware.)

The following items can be found on this tab:

The Device List
This four-column table takes up most of the tab’s area. It is a list of all the devices connected to 
your computer that may be used to establish network connections. From the Device List, you 
can:

● Enable and disable individual devices.
● Choose from multiple devices of the same type.

● Configure extended properties for mobile broadband devices.

● Change other settings and functions for connected devices.

 For more information, see “The Device List” on page 92.
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Device Priority
If there are two or more devices within a technology type and Automatic is selected in the 
Selection column, the devices within that technology type can be reordered to specify 
priority. The first device within a technology type has the highest priority for that technology 
type. Use the Up and Down buttons, located below the Device List, to change the order in 
which the devices are listed within their technology type.

Allow simultaneous connections
If this check box is selected, Sprint SmartView will allow you to establish more than one 
connection at a time. (For example, you could be connected to both WiFi and mobile 
broadband concurrently.)

If this check box is NOT selected, Sprint SmartView will prompt you to disconnect before 
allowing you to establish a second connection.

Note: Some VPN connections, such as those established with the Checkpoint VPN client, may be seen 
as separate connections by the Sprint SmartView software. If the Allow simultaneous 
connections check box is NOT selected, establishing such a VPN connection may trigger the 
“Multiple Connections Not Allowed” error message.

Prompt before switching connections
When in automatic connection mode, the Sprint SmartView software can automatically 
switch to a higher priority network if one becomes available. However, since the original 
connection is shut down once the new connection is fully established, this has the potential 
to disrupt any activity that was relying on the original connection. 

If this check box is selected, Sprint SmartView will prompt you for permission to switch 
networks before it actually does so.

CDMA/WiMAX Dual-Mode Settings (Dual-Mode Devices Only)
These settings appear only if your Sprint Mobile Broadband device supports both CDMA 
and WiMAX. Use these settings to specify when the Sprint SmartView software will switch 
the device from WiMAX mode to CMDA mode. There are two options:

● Automatic – Whenever you connect your device, the Sprint SmartView software will 
switch the device to WiMAX mode. If you fail to connect via WiMAX, the software will 
switch the device to CDMA mode.

● CDMA Only – The Sprint SmartView software will leave the device in CDMA mode at 
all times.

A third option, WiMAX Only, is not available at this time.

Profiles
Click Profiles to open the Network Profiles window.
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The Device List

The device list is a four-column table that appears at the top of the Hardware tab of the Settings 
window. It is primarily used to select and configure connected devices.

Devices Column
This column lists all the network access devices installed on your computer, grouped by the 
connection technologies they use. Each technology type heading is followed by the device 
names of the specific devices of that type that are installed on your computer. The technology 
types are:

● WiFi Devices

● WiMAX Devices

● Mobile Devices

Selection Column
This column allows you to specify which devices should be used to connect. The choices for 
this column are:

Automatic: Sprint SmartView will automatically choose the best device for this technology type.

Disabled: This option is necessary for some multi-function devices that can connect to only one 
type of network at a time. For example, you may have a WiFi/mobile broadband network 
adapter that can’t access both types of network simultaneously. When using such an adapter, 
you may have to temporarily shut down Sprint SmartView's access to one of these modes 
when you wish to use the other mode.

Manual: You can manually select the device to be used. After selecting this option, select the 
check box for the device you wish to use.

Status Column
This column identifies the operational status of the device (on or off).

Settings Column
If there are additional properties that may be configured for a specific device type, you will see a 
Modify button in this column. Click this button to open the Device Properties window, which 
provides additional configuration options for the device. There are two versions of this window:

● CDMA (see page 93)

● GSM (see page 96)

Note: If you click the button next to the Mobile Devices heading, you will get either the GSM or the CDMA 
version of the pop-up window, depending on which type of device is currently selected.
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Device Properties Window: CDMA Version

The CDMA version of the Device Properties window contains four sections that are used to 
configure the behavior of CDMA devices connected to your computer.   

Roaming Selection
The options in this group dictate whether Sprint SmartView will attempt to connect to a 
roaming network. Consult your service agreement for more information about roaming 
service and any charges that such service might incur. You can choose one of these 
options:

● Auto – Connect to the Nationwide Sprint Network when it is available, using roaming 
networks only when Sprint service is not available. If “Allow International Access” is 
checked, Sprint SmartView will include International roaming networks. Otherwise, 
only domestic roaming networks will be included in the automatic selection.

● Sprint Only – Connect only to the Nationwide Sprint Network. Never connect to other 
networks.
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Make a selection in the Roam Guard drop-down list box to specify whether you would like 
Sprint SmartView to display a warning message when you are about to connect to a roaming 
network for which there may be additional roaming charges.

● When Always Ask is selected, Sprint SmartView will always display the warning message 
when connecting to a roaming network.

● When Never Ask is selected, Sprint SmartView will never display the warning message.

Auto Connect when device is available
Select this check box if you want a connection to be automatically established each time you 
connect your device to your computer. The feature behaves slightly differently when RAS is 
selected (below) than it does when NDIS is selected. (See “Automatic Connection Upon Device 
Attachment” on page 25 for more information on the device-based autoconnect feature.

Note: This check box is available only if the Allow Simultaneous Connections check box on the 
Hardware settings tab is selected.

)

Connection Type
This group determines which software interface Sprint SmartView should use to communicate 
with your device. 

● NDIS allows more efficient communication with devices that support it.

● RAS is supported by more devices.

Note: Many devices support only one of these interfaces. If this is the case with your device, the interface 
that your device supports will be selected by default and you will not be able to change the selection.
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Device Configuration
This group of settings allows you to update the configuration files that reside on your device. 
Choose from the following options:

● Select the Disable Service Updates check box to disable all updates to your device’s 
configuration. This item disables all the other items in the Device Configuration group 
and disables network-initiated updates of the same information.

● Click Activate Device if the selected device has not yet been activated. This will initiate 
the device activation process. Note that this button will not be available if the selected 
device has already been activated.

● Click Update PRL to download the latest Preferred Roaming List (PRL). The PRL 
informs your device who Sprint's current roaming partners are. Keeping this list 
current ensures that your device will select networks with the most reasonable 
roaming fees.

● Click Update Profile to update the profile your device uses to establish connections.

● Click Update Firmware to download the latest version of your device's firmware (its 
onboard operating software).

Note: This group of settings is available only for some devices and will be disabled for others.

Disable LED
Select this check box if you want to disable the light on your device.

Select Device Mode
This option appears if you have a CDMA/GSM dual-mode device. Use it to select the mode 
to be used by the device. Sprint CDMA for North America selects the CDMA mode of the 
device. Sprint UMTS for Europe selects the GSM mode of the device.

Note: The Apply button will not be available if you change the selection in this menu. This is because 
Device Properties is a completely different window for GSM than it is for CDMA. You must click OK 
(which closes the window) to make the change.
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Device Property Window: GSM Version

The GSM version of the Device Property window is used to configure the behavior of GSM 
mobile broadband devices connected to your computer. 

Network Selection
This group’s settings control how Sprint SmartView selects which wireless network to connect 
to when you are travelling internationally.

● Auto instructs Sprint SmartView to automatically select the best network to connect to 
based on information provided by your wireless data service provider. In most cases, this 
will provide the best connection available. This option is strongly recommended for all but 
the most advanced users.

● Manual instructs Sprint SmartView to always connect to a specified network regardless of 
the availability of other wireless networks. This is useful if you know of a specific network 
that always provides you better service and you don’t mind occasional service outages 
when the specified network is unavailable.

WARNING: When manually scanning for networks, Sprint SmartView currently displays all mobile networks 
in the area. Some networks displayed may not allow you to connect. For this reason, manual 
network selection is not recommended for most users.
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Mode
This menu allows you to specify which technology will be used to connect.

● 3G Only — Connect via 3G technologies.

● GPRS Only — Connect via 2G technologies.
● Automatic — Use the default behavior of your wireless device. (Note that this option 

only appears if your device has a default behavior.)

Select Device Mode
This option appears if you have a CDMA/GSM dual-mode mobile broadband device. Use it 
to select the mode to be used by the device. Sprint CDMA for North America selects the 
CDMA mode of the device. Sprint UMTS for Europe selects the GSM mode of the device.

Note: The Apply button will not be available if you change the selection in this menu. This is because 
Device Properties is a completely different window for GSM than it is for CDMA. You must click OK 
(which closes the window) to make the change.
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The Location/GPS Tab

The Location/GPS tab lets you configure how Sprint SmartView locates nearby restaurants, 
banks, hotels, etc., using the Global Positioning System (GPS) in conjunction with Internet-
based mapping and search services.  (Click Tools > Settings > Location/GPS.)

Note: The settings on this tab will only be available if your device has a GPS function.

Disable GPS on Device
Selecting this check box disables GPS on your device and removes all GPS-related menu 
items and buttons from Sprint SmartView’s user interface.

Automatically start GPS when a CDMA connection is established
If this check box is selected, Sprint SmartView will begin acquiring GPS data automatically 
whenever you successfully connect to a CDMA mobile broadband network.
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Mapping Service Default
Lets you select which mapping and search service you want to use when searching for 
nearby restaurants, banks, etc.

GPS Mode
If your device supports multiple GPS modes, you can select which mode your device 
should use.

Configure GPS Applications
Click this button to open the GPS Applications window. This window can be used to add 
more application icons to the GPS Applications menu. (See “The GPS Applications Menu” 
on page 55 for more information.)

Test GPS
Click this button to test the GPS functions of your device by querying the device for your 
current location.

Note: Test results appear to the right. These data fields also appear when you hover over the GPS icon 
while GPS is turned on. See “GPS Data Fields” on page 55 for their descriptions.
Sprint SmartView Settings        99



The Sounds Tab

The Sounds tab lets you configure Sprint SmartView to play a sound when various events 
occur.  (Click Tools > Settings > Sounds.) You can also specify the sounds that Sprint 
SmartView plays. Select the Enable Sounds check box to enable this feature. Once the feature is 
enabled, select the check box for an event you wish to associate with a sound, and then click 
Browse to select the sound file (Windows .WAV format) for that event. 

You can specify sounds for the following events:

Connected
Plays a sound when Sprint SmartView successfully connects to a WiFi network.

Lost Connection
Plays a sound when Sprint SmartView disconnects from or loses its connection to a WiFi 
network.

Hotspot Authentication
Plays a sound when Sprint SmartView associates with a WiFi hotspot.
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The Updates Tab

The Updates tab allows you to specify when updates to the Sprint SmartView software and 
its databases are made. (Click Tools > Settings > Updates.)

Automatically download and install
Select this option to have Sprint SmartView automatically download and install product 
updates at regular intervals. 

Note: These updates are silent. You will not see the update wizard when updates are downloaded silently.

Prompt me to download and install
Select this option and enter an interval to have Sprint SmartView periodically prompt you to 
download and install product updates.

Manually download and install
Select this option if you want product updates to be downloaded only when you click 
Update Now.
Sprint SmartView Settings        101



Update Now
Click Update Now to have Sprint SmartView immediately check for available updates. If new 
updates are available, an update wizard will appear. This wizard allows you to choose which 
updates you want to download and install.

Apply Firmware Update
As part of its update process, Sprint SmartView can download updates to your device's 
firmware. Normally, such an update will be installed as soon as it is downloaded. In some 
cases, however, you can choose to defer the update’s installation until later. Click Apply 
Firmware Update to install an update that you had earlier chosen to defer.

The VPN Tab

The VPN tab specifies how Sprint SmartView accesses Virtual Private Networks (VPNs). 
(Click Tools > Settings > VPN.) 

Selecting Do not use VPN disables Sprint SmartView's VPN feature. Select this option if you do 
not plan to establish VPN connections.

You must choose one of the other two options and fill in the corresponding fields if you wish to 
do either of the following things:

● Connect to a VPN by clicking the VPN icon in the main window.
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● Automatically log into a VPN when you connect to a specific network. (See “Auto 
Launch” on page 103.)

Use existing VPN profile
Select this option if the VPN client software you will be using is supported by Sprint 
SmartView. Then, specify the supported VPN client software and the Login Profile that you 
want to use. (See “Supported Clients” on page 62 for more information on supported VPN 
client software.)

Use third party VPN client
Select this option if the VPN client software you will be using is not supported by Sprint 
SmartView, and then follow these steps:

1. Click Browse.

2. Select the program file to be launched.

3. Click Open. The path of the selected file should now appear in the Command line field.

4. If the VPN client software requires that additional parameters be included after the 
program filename on the command line, these may be entered in the Parameters field. 
Consult the documentation for the VPN client to determine if such parameters are 
needed.

See “Supported Clients” on page 62 for more information on which VPN client software is 
supported.

Auto Launch
Select this check box if you want new Network Profiles created to automatically launch the 
VPN software specified above each time you connect. Note that this is only a default. You 
can change this setting for an individual profile by selecting or clearing the VPN Auto 
Launch check box on the General tab of the properties for the desired profile. (See 
“Automatically Launching a VPN Connection” on page 64 for more information.)
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Section 7A

Troubleshooting Tools

� Event History Manager (page 106)
� WiFi Network Info (page 107)

� The Mobile Info Window (page 109)

� The WiMAX Info Window (page 112)
� About  Sprint SmartView (page 115)

This section provides additional information on using Sprint SmartView’s troubleshooting tools 
and procedures to resolve connection problems. Included are some frequently asked questions 
about troubleshooting Sprint SmartView.

Event History Manager

The Event History Manager (shown below) can be viewed from the Help menu in the main 
window. Click Help > Event History Manager to see events that have been logged (for example, 
connections, disconnections, errors). 

From this window, you can:

● Double-click any item in the list to see more information about that event

● Use the options in the Filter by field to limit the events displayed to a particular date range, 
connection technology, or event type.
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● Check your total usage data for mobile broadband, WiFi, or WiMAX by viewing the 
statistics in lower right corner of the window.

Note: Byte totals displayed are approximate and are not used to calculate data charges.

● Click Reset Event History Manager to delete all the currently logged events and reset 
the usage data to 0.

Note: For WiFi connections, the usage estimates assume 1,500 bytes per packet received and 150 bytes 
per packet sent.

WiFi Network Info

To view information about a WiFi network you are connected to or about your current WiFi 
device, select WiFi Info from the Tools menu. 

Network Tab
The Network tab contains information about the IP settings for and the amount activity on 
your current WiFi connection (if any).

● IP address – The Internet address your computer is using for the current WiFi network 
connection. Ordinarily, the address displayed here is assigned only for the duration of 
the current connection. It is most likely not permanently assigned to your computer.
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● Gateway – The address of the device that is responsible for routing all of the network 
traffic you send over the WiFi connection.

● DNS server – The address of the server your computer is using to translate Internet 
addresses from text to numeric format and back. For example, your browser might use 
the DNS server to convert sprint.com to 206.159.101.241.

● DHCP server – The address of the server that assigned your computer’s network 
configuration for the current wireless connection.

● WINS server – The address of the server (if any) that your computer is using to find the 
names of computers on a Windows network. 

● Activity – The number of packets of data that your computer has sent and received over 
the WiFi connection since it was established.

Device Tab
The Device tab contains information about your current WiFi device (if any). 

● Vendor description – The name of your WiFi device, as reported by its onboard operating 
software.

● MAC address – The Hardware Address of the device. MAC (Media Access Control) 
addresses are unique number sequences assigned by the device’s manufacturer and 
usually cannot be altered. These addresses are used for transferring data by hardware-
level protocols such as Ethernet and 802.11 (WiFi). Higher level protocols such as the 
TCP/IP Protocol Suite used by the Internet have their own addressing schemes, but still 
rely on the hardware-level protocol for the transfer of data between individual nodes on a 
network.
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● Driver version – The version of the driver for the device that is currently installed on 
your computer.

● Firmware version – The version of the device's onboard operating software.

The Mobile Info Window

To view information about your mobile broadband device or your current mobile 
broadband connection (if any), select Mobile Info from the Tools menu.  

Note: The information displayed in this window is provided by your device and its drivers. If the device 
does not provide this information or the information provided is incorrect, this will be reflected in the 
displayed data.
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Device Tab
The Device tab displays information about your current mobile device (if any).

Hardware information
● Device name – The name used internally by software applications to uniquely identify 

your mobile broadband device.
● Device description – The user-friendly name of your device.

● Manufacturer – The name of the manufacturer of your device. 

● Modem model – The model name of your device.
● Revision – The revision field contains manufacturer-specific information about the version 

of your device. It may, for example, contain additional information about your device's 
model number or its firmware version.

● ESN – Your mobile broadband device’s Electronic Serial Number.

● Technology – The type of mobile broadband device you are using (CDMA or GSM).

● Firmware version – The version of your device's onboard operating software.
● Hardware version – The version of your device's hardware.

● Modem port – The communications (COM) port that your device is currently attached to.

User information
● User name – Your Network Access Identity (NAI), usually in the form of 

username@companyabc.com

● Phone Number (MDN) – The telephone number of your mobile broadband device.
● Home Carrier Name – The name of the wireless service provider that your device 

considers to be its “home” network (“Sprint”).

● Home Carrier ID – The ID of the wireless service provider that your device considers to be 
its “home” network.

● PRL version – The version of the file on your device that contains the Preferred Roaming 
List.

● MSID (IMSI_S) – Your device's IMSI (International Mobile Subscriber Identity) code. The 
IMSI allows any mobile network to identify the home country and network of the 
subscriber.
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Network Tab
The Network tab contains information about the mobile network you are currently 
connected to (if any).   

Carrier information
● Network name – The name of the mobile carrier you are currently connected to.
● System ID – The ID of the network to which your device is currently connected.

Session information
● Connected – Indicates whether you are currently connected to a mobile broadband 

network.

● Roaming – Indicates whether you are currently connected to a mobile broadband 
network that is not your “home” network.

● MIP error – The last Mobile IP Error Code reported by your device.

● Signal strength (dBm) – The strength of the signal being received from this network, 
expressed in dBm. 

● Data sent – The amount of data sent over this connection since it was established (in 
bytes).

● Data received – The amount of data received over the current connection (in bytes).
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● IP address – The IP Address you are using for the current mobile broadband connection. 
Ordinarily, the address displayed here is assigned only for the duration of the current 
connection. It is most likely NOT permanently assigned to your computer.

● Gateway address – The address of the default gateway that has been assigned to your 
device.

● Workmode – The current workmode assignment for your device (if available).

The WiMAX Info Window

To view information about your WiMAX device and the WiMAX network you are currently 
connected to (if any), select WiMAX Info from the Tools menu.

Network Tab
The Network tab contains information about the IP settings for and the amount of activity on 
your current WiMAX connection (if any).

● IP address – The Internet address your computer is using for the current WiMAX network 
connection. Ordinarily, the address displayed here is assigned only for the duration of the 
current connection. It is most likely not permanently assigned to your computer.

● Gateway – The address of the device that is responsible for routing all of the network 
traffic you send via WiMAX.

● DNS server – The address of the server your computer is using to translate Internet 
addresses from text to numeric format and back. For example, your browser might use 
the DNS server to convert sprint.com to 206.159.101.241.

● DHCP server – The address of the server that assigned your computer's network 
configuration for the current WiMAX connection.

● WINS server – The address of the server (if any) that your computer is using to find the 
names used by computers in a Windows workgroup.

● Activity – The number of packets of data that your computer has sent and received over 
the WiMAX connection since it was established.
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Device Tab
The Device tab contains information about your current WiMAX Device (if any).

● MAC Address – The Hardware Address of the device. MAC (Media Access Control) 
addresses are pre-configured by the device's manufacturer and usually cannot be 
altered. These addresses are used for transferring data by hardware-level protocols 
such as Ethernet or WiMAX. Higher level protocols such as the TCP/IP Protocol Suite 
used by the Internet have their own addressing schemes, but still rely on the 
hardware-level protocol for the transfer of data between individual nodes on a 
network.

● Library Version – The version of the software interface of the device’s WiMAX chipset.

● Firmware Version – The version of your WiMAX device's onboard operating software.
● Driver Version – The version of the driver for the device that is currently installed on 

your computer.

● BaseBand Chip – The version of the chip in your WiMAX device that formulates the 
baseband WiMAX signal.

● RF Chip Version – The version of the chip in your WiMAX device that modulates and 
multiplexes the baseband WiMAX signal for RF transmission.

● Calibration Status – Indicates whether your WiMAX device has been calibrated.

● Antenna Calib – The Sprint SmartView software does not currently output this data.

● Antenna Gain Diff – The Sprint SmartView software does not currently output this data.
● Tx Power Offset – The Sprint SmartView software does not currently output this data.

● MAC Version – The Sprint SmartView software does not currently output this data.

● Advanced – Click to open the Advanced WiMAX Information window.
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Advanced WiMAX Information
Clicking Advanced on the Device page of the WiMAX Info window opens the Advanced WiMAX 
Information window (shown below). This window provides advanced information for 
troubleshooting the WiMAX airlink.

● Rx Power – The strength of the signal being received by your WiMAX device.

● CINR – Carrier to Interference + Noise Ratio. This is an indication of how strong the 
desired signal is compared to any interfering signals and noise. A value of 27 as shown

● BSID – Base Station ID. The BSID of the base station you are currently connected to.
● TX Power – The level of power being used for transmissions by your WiMAX device.

● Preamble Index – The Preamble Index of the WiMAX base station sector you are currently 
connected to.

● NAP-ID - Network Access Point ID. The NAP-ID of the base station you are currently 
connected to.
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About  Sprint SmartView

Select About Sprint SmartView from the Help menu to open a window displaying version 
information for the Sprint SmartView software and the phone number for Sprint Customer 
Service.  

Click System Info to open a window containing extensive information about your 
computer's configuration. This information may be useful to a Customer Service 
Representative should you need help in resolving a problem.
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Section 7B

Troubleshooting Procedures

� Application Launch Issues (page 116)
� Connection Issues (page 117)

� Device Issues (page 118)

� Numbered Errors (page 119)
This section provides troubleshooting information on application launch issues, device issues, 
and interpreting numbered errors in Sprint SmartView.

Application Launch Issues

Application is not visible after launch
Sprint SmartView is designed to open in the display state from which it was last exited. As such, 
it is possible that Sprint SmartView will launch directly to its minimized state, causing you to 
assume that it is not running.

Resolution
Look for a minimized Sprint SmartView icon in the Windows taskbar. If Sprint SmartView is 
present, just click on it to return it to its normal state.

Autolaunching of Sprint SmartView at startup
The Sprint SmartView installation can be configured to allow the application to automatically 
launch when your computer boots up or when a new user logs into the machine. This may (or 
may not) be the way you prefer it to behave.

Resolution
You can access the setting that controls this behavior by selecting Settings from the Tools menu 
and then selecting the Client tab. Select (or clear) the Automatically run this application on 
machine startup check box to specify whether Sprint SmartView should be automatically 
launched.

Windows XP’s native WiFi management is shut down at startup
This behavior is intentional. Sprint SmartView provides significantly more powerful WiFi 
management than XP’s native WiFi engine. However, if you prefer XP’s native tool, you can 
disable Sprint SmartView’s WiFi management entirely. (See “Use this as my default Wi-Fi 
management utility” on page 89 for more information.)
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Connection Issues

Multiple Connections Not Allowed
This error message appears if both of the following conditions are met:

● The Allow simultaneous connections check box on the Hardware tab of the Settings 
window (see page 91) is not selected.

● You attempted to establish a second connection while you were still connected using 
another technology.

Note: VPN connections established by certain VPN client software (such as Check Point VPN) may appear 
to Sprint SmartView as a second connection. In such cases, you may also see this error.

Resolution
To prevent this error message from appearing:

1. Select Settings from the Tools menu.

2. Click the Hardware tab.

3. Select the Allow simultaneous connections check box and click OK.
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Device Issues

In some circumstances, Sprint SmartView will not be able to use your WiFi, WiMAX, or mobile 
broadband device.

Device Disabled
You can enable an attached wireless device by selecting Enable 3G, 4G, or Enable WiFi from the 
File menu. 

Note: On Windows Vista and Windows 7 systems, these options may be unavailable (grayed out) at all 
times. This may be because of security restrictions in your security configuration. Running the 
application as an administrator may allow access to these options. Follow these steps:
 1. Close the Sprint SmartView sofware.
 2. Right click on the Sprint SmartView icon on the computer’s desktop. A short menu 

appears.
 3. Select Run As Administrator from the menu.

No Wireless Device Detected
Sprint SmartView will display “No Wireless Device Detected” if it cannot communicate with the 
wireless device.

Resolution
Causes for this may include:

● Devices (such as wireless phones) that must be tethered to your computer with a data 
cable (such as USB), but are not currently properly connected. Make sure the cables for 
devices that require them are properly attached to both your computer and the device.

● External devices (such as wireless phones) that are not currently powered on. Make sure 
external devices are switched on. Make sure the batteries of battery-powered devices are 
charged. Make sure devices that must be plugged into an electrical outlet are plugged in.

● PC Card, USB, or ExpressCard devices that are not properly inserted. Make sure such 
devices are firmly seated in the appropriate slots.

● The wrong device is selected in the Hardware tab of the Settings window. Ordinarily, 
Automatic selection should be specified in the Selection column. If Manual selection is 
specified, verify that the selected device is the device you are trying to use. (See “The 
Hardware Tab” on page 90 for more information.)

● No driver or incorrect driver installed. Ensure that the latest drivers for the device are 
correctly installed according to the instructions of the device’s manufacturer.
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Numbered Errors

Error 67 
Your Sprint user name, password, or both may be incorrect. Possible causes include the 
following:

● Sprint Mobile Broadband device account credentials have changed.
● Sprint Mobile Broadband device is no longer provisioned for service.

Resolution
● Select Update Data Profile IOTA from the Tools menu. This instructs your device to 

update its provisioning information so that it may properly use Sprint data services. 

● Rerun the Activation Wizard. See page 5 for a tutorial on the Activation Wizard.
● Contact Sprint Customer Service to ensure that there are no problems with the 

account.

Error 131
Your Sprint user name or password may be incorrect. Your Sprint Mobile Broadband device 
account credentials may have changed.

Resolution
● Select Update Data Profile IOTA from the Tools menu. This instructs your device to 

update its provisioning information so that it may properly use Sprint data services.
● Rerun the Activation Wizard. See page 5 for a tutorial on the Activation Wizard.

Error 619
A connection to the remote computer could not be established, so the port used for this 
connection was closed. Possible causes for this error include the following:

● Network resources are unavailable.
● Attempting to reconnect before your device has finished disconnecting from a 

previous call.

● Your device may be malfunctioning.

Resolution
● Wait 30 seconds, and then try to connect again.
● Remove the device and reinsert it into the computer.

● Reboot the computer.
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Error 628
The connection was terminated by the remote computer before it could be completed. Possible 
causes for this error include the following:

● Call was dropped due to poor signal.
● Call was dropped due to network congestion.

Resolution
● If indoors, move closer to a window, exterior wall or move to a higher level. Re-orienting 

the computer or wireless device may help as well.

● Wait 30 seconds, and then try to connect again.

Error 633
The device is already in use or is not configured properly. Possible causes for this error include:

● There is a problem with some of the drivers installed for the wireless device.

● Another application such as a fax program or PDA device software is attempting to use 
the port.

Resolution
● Shut down all FAX and PDA software and launch Sprint SmartView again. Examples of 

common applications that can cause this type of problem include: PalmSource Hotsync, 
Microsoft ActiveSync, and Blackberry Desktop Manager.

● Uninstall any other wireless device connection management software installed on the 
computer. 

● Re-install Sprint SmartView.

Error 668 
The connection was dropped. Possible causes for this error include:

● Call was dropped due to poor signal.

● Call was dropped due to network congestion.

Resolution
● If indoors, move closer to a window, exterior wall, or a higher level. Reorienting the 

computer or wireless device may help as well.
● Reboot the computer.

● Select Update Data Profile IOTA from the Tools menu. This instructs your device to update 
its provisioning Information so that it may properly use Sprint data services.
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Error 678

The remote computer is not responding. Possible causes for this error include:

● Poor signal.

● Network resources are unavailable.

Resolution
● If indoors, move closer to a window or exterior wall or move to a higher level. 

Reorienting the computer or wireless device may help as well.

● Wait 30 seconds, and then try to connect again.

Error 691
Access was denied because the supplied user name, password, or both is invalid on the 
domain. Possible causes for this error include:

● Poor signal.

● Sprint Mobile Broadband device account credentials have changed.

Resolution
● If indoors, move closer to a window or exterior wall or move to a higher level. 

Reorienting the computer or wireless device may help as well.
● Reboot the computer.

● Select Update Data Profile IOTA from the Tools menu. This instructs your device to 
update its provisioning information so that it may properly use Sprint data services.

Error 692 
There was a hardware failure in the device. Possible causes of this error include:

● Wireless device is defective or broken.

● Problem with PC Card Slot, ExpressCard slot, or USB port. 

Resolution
● Close Sprint SmartView, reinsert the device, and launch Sprint SmartView again.
● Reboot the computer.

● Try connecting the device to another slot (or port).

Error 718
PPP/Network Timeout. Possible causes for this error include:

● Poor signal.

● Network resources are unavailable.

Resolution
● If indoors, move closer to a window or exterior wall or move to a higher level. 

Reorienting the computer or wireless device may help as well.
● Wait 30 seconds, and then try to connect again.

● Reboot the computer.
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Error 719
PPP termination by remote machine. Possible causes for this error include the following:

● Poor signal.

● Network resources are unavailable.

Resolution
● If indoors, move closer to a window or exterior wall, or move to a higher level. Reorienting 

the computer or wireless device may help as well.

● Wait 30 seconds, and then try to connect again.

● Reboot the computer.

Error 777
The connection attempt failed because the connecting device on the remote computer is out of 
order. Possible causes for this error include:

● Poor signal.
● Network resources are unavailable.

● There is a problem with one of the wireless device drivers.

Resolution
● If indoors, move closer to a window or exterior wall, or move to a higher level. Reorienting 

the computer or wireless device may help as well.

● Wait 30 seconds, then try to connect again.
● Close Sprint SmartView, reinsert the device, and launch Sprint SmartView again.

● Reboot the computer.

● Uninstall any other software that manages wireless connections (if it is present on the 
computer).

● Reinstall Sprint SmartView.

Error 1012
Client-initiated IOTA (Internet Over The Air) fails. Possible causes for this error include:

● Poor signal.

● Network resources are unavailable.

● MDN (Phone Number) or MSID (Subscriber Identification Number) was entered 
incorrectly in the Activation Wizard.

● The device has not been provisioned on the network yet.

Resolution
● If indoors, move closer to a window or exterior wall, or move to a higher level. Reorienting 

the computer or wireless device may help as well.
● Wait 5 minutes and try to update the device profile.
● Rerun the Activation Wizard.
● Contact Sprint Customer Service to ensure that there are no problems with the account.
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Section 7C

Frequently Asked Questions

� General Questions (page 123)
� WiFi Questions (page 124)

� Device Issues (page 125)

� GPS Questions (page 126)
This section presents some Frequently Asked Questions to assist in your general 
understanding of Sprint SmartView and assist when troubleshooting general issues with the 
software and wireless devices.

General Questions

Why Does Sprint SmartView Shut Down Windows “Zero Config”?
“Zero Config” is the WiFi management utility built into Windows XP. Sprint SmartView 
provides significantly enhanced WiFi management capabilities, such as: 

● Automatically logging on to all of Sprint partner WiFi networks.

● Specifying connection priority on a network by network basis, allowing dynamic 
roaming not only to other WiFi networks, but also to WiMAX and mobile broadband 
networks (and vice versa).

● Optionally automatically shutting down your WiFi connection when you establish a 
connection to another network technology, such as the local network at your home or 
office.

● Configuring a VPN client, your browser, or many other applications to be 
automatically launched when you connect to selected WiFi networks.

In order to provide these enhanced capabilities, Sprint SmartView must manage WiFi 
connections itself. Since WiFi cannot be managed by two different applications 
simultaneously, Zero Config is shut down.

Note: The native WiFi management tools in Windows Vista and Windows 7 are completely different from 
XP’s Zero Config. These operating systems do not allow third-party applications such as Sprint 
SmartView to shut the tools down. However, they do provide support for external enhancements. This 
allows Sprint SmartView to provide almost as much control on Vista and Windows 7 as it does on XP, 
without actually shutting the tools down.
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How do I return WiFi Control to Zero Config?
Sprint SmartView returns control to Zero Config automatically whenever you exit the Sprint 
SmartView application. If you would rather use Zero Config to manage WiFi connections even 
when Sprint SmartView is running, you must disable Sprint SmartView’s WiFi management.

1. Select Settings from the Tools menu. The Settings window appears.

2. Select the Client tab.

3. Clear the Use this as my default WiFi management utility check box.

4. Click OK.

Note: This procedure disables all of Sprint SmartView’s WiFi features and hides the WiFi Connections 
Interface entirely.

How do I stop Sprint SmartView from launching every time I restart my computer?
1. Select Settings from the Tools menu.

2. Select the Client tab.

3. Clear the Automatically run this application on machine startup check box.

4. Click OK.

WiFi Questions

Why Does Sprint SmartView Keep Scanning for WiFi Networks?
Sprint SmartView will continue to scan until it finds one or more available networks or hot spots. 
If it keeps scanning, there are most likely no WiFi networks or hot spots in the area.

“Closed” networks are a special case. Although Sprint SmartView can detect whether closed 
networks are in the area, it can’t actually identify (or connect to) individual closed networks 
without probing for these networks using their exact names. To enable this, you have to create a 
profile for the network you wish to connect to. (See “Accessing a Closed Network” on page 38 
for more information.)

Why do I keep losing my connection?
This may be due to interference caused by other devices like cordless phones, microwave 
ovens, and other 2.4 GHz band devices. 

Why am I unable to connect to a network that I can see in Sprint SmartView?
Causes for this include:

● Signal strength from the wireless Access Point may not be strong enough to allow reliable 
connections. 

● It may not be a publicly available Access Point. Many companies or campuses will use 
wireless networking within their buildings, but will not grant public access.
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Device Issues

In some circumstances, Sprint SmartView will not be able to use your WiFi device, your 
WiMAX device, your mobile broadband device, or all three.

Disabled
WiFi, WiMAX, and mobile broadband devices, like any other network adapters, can be 
disabled by Microsoft Windows. The status text in Sprint SmartView's main window will 
indicate when a device has been disabled.

Resolution
Re-enable the device. (See “Device Disabled” on page 118 for more information.)

No Wireless Device Detected
Sprint SmartView will display “No Wireless Device Detected” if it cannot communicate with 
the wireless device. 

Resolution
Causes for this may include:

● Devices (such as wireless phones) that must be tethered to your computer with a 
data cable (such as USB), but are not currently properly connected. Make sure the 
cables for devices that require them are properly attached to both your computer and 
the device.

● External devices (such as wireless phones) that are not currently powered on. Make 
sure external devices are switched on. Make sure the batteries of battery-powered 
devices are charged. Make sure devices that must be plugged into an electrical outlet 
are plugged in.

● PC Card, USB, or ExpressCard devices that are not properly inserted. Make sure such 
devices are firmly seated in the appropriate slots.

● The wrong device is selected in the Hardware tab of the Settings Window. Ordinarily, 
Automatic selection should be specified in the Selection column. If Manual selection 
is specified, verify that the selected device is the device you are trying to use. (See 
“The Hardware Tab” on page 90 for more information.)

● No driver or incorrect driver installed. Ensure that the latest drivers for the device are 
correctly installed according to the instructions of the device’s manufacturer.
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GPS Questions

Terminology
GPS = Global Positioning Systems

HEPE = Horizontal Estimated Position Error (equates to GPS accuracy)

NMEA = National Marine Electronics Association

LBS = Location-Based Services

BMF = Business Mobility Framework

IMQ = Idle Mode Query (Service Option 35) 

AFLT = Advanced Forward Link Trilateration

Questions About GPS Technology

What is GPS?
GPS satellites transmit signals to equipment on the ground. GPS receivers passively receive 
satellite signals, but do not transmit. There are various GPS standards for User Plane and 
Control Plane.

What is GPS User Plane?
It is the ability to execute GPS requests at the subscriber level (that is, on your mobile 
broadband device).

What is GPS Control Plane?
It is the ability to execute GPS Requests at the server level (that is, via the network).

What GPS mode options are supported?
GPS on a Sprint Mobile Broadband device works like any other GPS device. Sprint currently 
offers GPS Basic service. GPS Premium service will be available in the near future.

What is Location-Based Service (LBS)?
Location-based services provide current position information from the Location Server on the 
Sprint network and allow you to find nearby locations such as gas stations, hotels, restaurants, 
and banks. 

What is GPS Basic?
GPS Basic allows the Mobile Broadband device to use GPS outdoors only. In this mode, the 
GPS receiver (device) requires an unobstructed view of GPS satellites (the sky), and, like any 
other GPS device, often does not perform well within forested areas or near tall buildings.

Sprint GPS Basic is based on gpsOne® standards and uses LBS for the first fast GPS fix. GPS 
coordinate values are made available for applications via a local GPS NMEA communications 
port.

What is GPS Premium?
GPS Premium is an enhanced GPS experience that will be available from Sprint in the near 
future. It is not currently available.
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Is a GPS Subscription required?
For GPS Basic, no GPS subscription is required. For GPS Premium, a GPS subscription will 
be required.

What is the difference between GPS Basic and GPS Premium?
GPS Basic is for outdoor use similar to the capabilities of a typical GPS device. GPS 
Premium is an enhanced GPS capability allowing GPS to be used indoors and outdoors.

What is NMEA?
NMEA 0183 is a standard protocol, used by GPS Receivers to transmit data. NMEA Output 
is composed of various strings. Sprint Mobile Broadband devices support the following 
strings: $GPGGA, $GPRMC, $GPGSA, $GPGSV.

When does one need NMEA?
You only need NMEA when using a GPS Application that employs an NMEA output stream 
(see “What is a GPS Application?” on page 127). We recommend not activating the NMEA 
stream unless you are going to use it; this will ensure the best possible data performance 
on your device.

What is Business Mobility Framework (BMF)?
BMF is an LBS infrastructure that allows GPS server-based solutions to request and obtain 
device location information.

What is enhanced local search?
It is a quick and easy method to run local search queries. This allows you to find locations 
and directions to locations/businesses via the Sprint SmartView software. The enhanced 
local search uses LBS, thus allowing you to search for Sprint Nextel stores, hotels, 
restaurants, coffee shops, banks, etc.

How do I get the enhanced local search feature?
The enhanced local search is available as part of the latest Sprint SmartView software. It 
allows you to submit custom queries or use one of the predefined finder services that are 
included by default.

What is a GPS Application?
A GPS Application is an application that uses NMEA data to get regular location coordinate 
updates and values typically displayed in a user interface. Examples of GPS Applications 
are: Microsoft Streets & Trips and Map Point.

How do I develop GPS Applications?
Device GPS SDKs (software development kits) are available. We recommend joining the 
Sprint Nextel Software Application Development Program to get the appropriate and latest 
SDK information. 
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GPS and Sprint SmartView

How do I enable GPS?
Uncheck Disable GPS in the Location/GPS tab.

How do I display the GPS Receiver?
The GPS Search menu appears at the bottom of the main window. Hovering over the satellite 
icon near the upper-right corner of the main window, displays the GPS data received. Clicking 
this icon displays the GPS Application Launch menu.

Does GPS work when Privacy is On?
No. Turning privacy on means you do not want your device to be discoverable via GPS. Thus, 
GPS is not started on the device.

How do I start GPS NMEA?
Connect your GPS-capable mobile broadband device and start the Sprint SmartView software. 
Click the satellite icon to turn it white (not yellow or gray). Additionally, NMEA will be started 
automatically when you launch an application from the GPS Application Launch menu.

How do I stop GPS NMEA?
Click the satellite icon to turn it yellow or gray (not white).

How do I configure my NMEA port?
Three NMEA ports are created when you install the Sprint SmartView software. (See “GPS/
NMEA COM Ports” on page 57 for more information on the ports created.) A particular port may 
be assigned to a launched GPS application when you add it by entering the port number in the 
Parameters field of the Application Configuration window. (See “Adding a GPS Application to 
the GPS Applications Window” on page 58.)

How do I use GPS Applications with a Sprint GPS-Capable Device?
There are three things you must do to make a GPS application work with your Sprint GPS-
capable device:

● Add the GPS application according to the instructions in “Adding a GPS Application to 
the GPS Applications Window” on page 58, making sure that you properly assign an 
NMEA port number to the application.

● Typically, the application that you wish to use has to be informed of the port number it 
has been assigned. Consult the documentation for the application you wish to use to see 
where you need to enter this information.

● Start GPS NMEA in the Sprint SmartView software. See “How do I start GPS NMEA?” 
(above).

Can LBS/GPS be used when the device is configured for NDIS?
Yes, both Location-Based Services and GPS services are supported while the device is in NDIS 
mode.
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Service Agreement 
General Terms and Conditions of Service 

Please note these terms may not be the most current version. A current version of the terms is 
available at our website or upon request.

Para solicitar esta literatura en español, por favor contactar a 1-800-777-4681.

Basic Definitions
In this document: (1) “we,” “us,” “our,” “Nextel,” and “Sprint” mean Sprint Solutions, Inc. and its 
affiliates doing business as Sprint, Sprint PCS, or Nextel; (2) “you,” “your,” “customer,” and “user” 
mean an account holder or user with us; (3) “Device” means any phone, aircard, mobile 
broadband device, any other device, accessory or other product we sell to you or that is active 
on your account with us; and (4) “Service” means our offers, rate plans, options, wireless 
services or Devices on your account with us.

The Service Agreement 
The Service Agreement (“Agreement”) is a contract under which we provide and you accept our 
Services. In addition to these Terms and Conditions of Service (“Ts&Cs”), there are several parts 
to the Agreement, including, but not limited to, the Subscriber Agreement you sign or accept, the 
detailed plan or other information on Services we provide or refer you to during the sales 
transaction, and any confirmation materials we may provide you. It is important that you carefully 
read all of the terms of the Agreement.

Services Covered By These Ts&Cs & Additional Terms
These Ts&Cs apply to our standard wireless Services and any other Service we offer you that 
references these Ts&Cs. If you are a business customer, your Agreement is exclusively 
governed by the Standard Terms and Conditions for Communications Service, the Wireless 
Services Product Annex, and the applicable Product specific terms posted at http://
www.sprint.com/ratesandconditions. Additional terms and conditions for Equipt for Business 
customers may be found at http://www.sprint.com/equipt. Rates and charges are listed in the 
Service Plans & Rates Guide for business customers and any supplemental materials. 
Additional terms will apply when you use certain Services, typically those you can access 
online (for example, picture/video Services, online forums, etc.). Additional terms will apply to 
certain Devices and applications (the terms may come from Sprint or a third party) and will be 
provided with the Device or prior to the use of the application, as applicable. Additional terms 
will also apply if you activate Services as part of a bundle with another company’s services (for 
example, cable services, home phone services, etc.). The additional terms for bundled Services 
may either modify or replace certain provisions in these Ts&Cs, including terms relating to 
activation, invoicing/payment, and disputing charges. Also, a different dispute resolution 
provision may apply to services provided by another company (the dispute resolution 
provisions in this Agreement still apply to our Services). You will be provided details on any 
additional terms with your selection of any bundled Service.
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Our Policies
Services are subject to our business policies, practices and procedures (“Policies”). You 
agree to adhere to all of our Policies when you use our Services. Our Policies are subject to 
change at anytime with or without notice.

When You Accept The Agreement
You must have the legal capacity to accept the Agreement. You accept the Agreement when 
you do any of the following: (a) accept the Agreement through any printed, oral, or electronic 
statement; (b) attempt to or in any way use the Services; (c) pay for the Services; or (d) open 
any package or start any program that says you are accepting the Agreement when doing 
so. If you don’t want to accept the Agreement, don’t do any of these things.

Term Commitments & Early Termination Fees
Many of the Services (for example, Device discounts) that we offer require you to maintain 
certain Services with us for a minimum term, usually 1 or 2 years (“Term Commitment”). You 
will be charged a fee (“Early Termination Fee”) for each line of Service that you terminate early 
(i.e., prior to satisfying the Term Commitment) or for each line of Service that we terminate 
early for good reason (for example, violating the payment or other terms of the Agreement), 
but such Early Termination Fee may be prorated based on your remaining Term Commitment. 
Early Termination Fees are a part of our rates. Your exact Term Commitment and Early 
Termination Fee may vary based on the Services you select and will be disclosed to you 
during the sales transaction. Carefully review any Term Commitment and Early Termination 
Fee requirements prior to selecting Services. After you have satisfied your Term Commitment, 
your Services continue on a month-to-month basis without any Early Termination Fee, unless 
you agree to extend your Term Commitment or agree to a new Term Commitment. As 
explained directly below, there are instances when you will not be responsible for an Early 
Termination Fee for terminating Services early.

When You Don’t Have To Pay An Early Termination Fee
You aren’t responsible for paying an Early Termination Fee when terminating Services: (a) 
provided on a month-to-month basis; (b) consistent with our published trial period return 
policy; or (c) in response to a materially adverse change we make to the Agreement as 
described directly below.

Our Right To Change The Agreement & Your Related Rights
We may change any part of the Agreement at any time, including, but not limited to, rates, 
charges, how we calculate charges, or your terms of Service. We will provide you notice of 
material changes, and may provide you notice of non-material changes, in a manner 
consistent with this Agreement (see “Providing Notice To Each Other Under The Agreement” 
section). If a change we make to the Agreement is material and has a material adverse effect 
on Services under your Term Commitment, you may terminate each line of Service materially 
affected without incurring an Early Termination Fee only if you: (a) call us within 30 days after 
the effective date of the change; and (b) specifically advise us that you wish to cancel Services 
because of a material change to the Agreement that we have made. If you do not cancel 
Service within 30 days of the change, an Early Termination Fee will apply if you terminate 
Services before the end of any applicable Term Commitment.
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Our Right To Suspend Or Terminate Services
We can, without notice, suspend or terminate any Service at any time for any reason, including, 
but not limited to: (a) late payment; (b) exceeding an Account Spending Limit; (c) harassing/
threatening/abusing/offending our employees or agents; (d) providing false information; (e) 
interfering with our operations; (f) using/suspicion of using Services in any manner restricted by 
or inconsistent with the Agreement; (g) breaching the Agreement or failing to follow our Policies; 
(h) providing false, inaccurate, dated or unverifiable identification or credit information, or 
becoming insolvent or bankrupt; (i) modifying a Device from its manufacturer specifications; (j) 
failing to use our Services for  an extended period of time; (k) failing to maintain an active 
Device in connection with the Service;  or (l) if we believe the action protects our interests, any 
customer’s interests or our network.

Your Right To Change Services & When Changes Are Effective
The account holder can typically change Services upon request. In some instances, changes 
may be conditioned on payment of an Early Termination Fee or certain other charges, or they 
may require a new Term Commitment. Changes to Services are usually effective at the start of 
the next full invoicing cycle. If the changes take place sooner, your invoice may reflect pro-rated 
charges for your old and new Services. We may, but are not obligated to, provide you the 
opportunity to authorize someone else to make changes to your Services, which will include the 
authority to make changes that will extend your Term Commitment. You are responsible for any 
changes to your Services made by a person you authorize and those changes will be treated 
as modifications to this Agreement.

Your Right To Terminate Services
You can terminate Services at any time by calling us and requesting that we deactivate all 
Services. In addition, if you return or provide your Device to Sprint and fail to either deactivate 
service on the Device or activate another Device in connection with your Service, we reserve the 
right to terminate your Service, and if you are subject to a Term Commitment, you may be 
charged all or part of an Early Termination Fee. You are responsible for all charges billed or 
incurred prior to deactivation. If Services are terminated before the end of your invoicing cycle, 
we won’t prorate charges to the date of termination and you won’t receive a credit or refund for 
any unused Services. Except as provided above, you must also pay us an Early Termination Fee 
for each line of Service that you terminate early.

Credit Checks & Credit Information
We agree to provide you Services on the condition you have and maintain satisfactory credit 
according to our standards and policies. You agree to provide information we may request or 
complete any applications we may provide you to facilitate our review. We rely on the credit 
information you furnish, credit bureau reports or other data available from commercial credit 
reference services, and other information (such as payment history with us) to determine 
whether to provide or continue to provide you Services. The Services we offer you can vary 
based on your credit history. We may at any time, based on your credit history, withdraw or 
change Services, or place limits or conditions on the use of our Services. You agree to provide 
us updated credit information upon request. We may provide your payment history and other 
account billing/charge information to any credit reporting agency or industry clearinghouse.
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Account Spending Limits (“ASL”)
An ASL is a temporary or permanent limit (typically based on credit history, payment history, 
or to prevent fraud) we place on the amount of unpaid charges you can accumulate on 
your account, regardless of when payment on those charges is due. We reserve the right to 
determine which charges count towards an ASL. If you have an ASL, we may suspend your 
Services without prior notice if your account balance reaches the ASL, even if your account 
is not past due. We may impose or increase an ASL at any time with notice. An ASL is for 
our benefit only and should not be relied on by you to manage usage. 

Deposits & Returning Deposits
We may at any time require a deposit, as a guarantee of payment, for you to establish or 
maintain Service (“Deposit”). By providing us a Deposit, you grant us a security interest for 
all current or future amounts owed to us. We may change the Deposit at any time with 
notice. You can’t use a Deposit to make or delay payments. The Deposit, the length of time 
we hold the Deposit, and changes to the Deposit are determined based on your credit 
history, payment history and other factors. Unless prohibited by law, we may mix Deposits 
with our other funds and it won’t earn interest and we reserve the right to return the Deposit 
as a credit on your invoice at anytime. If your Services are terminated for any reason, we 
may keep and apply your Deposit to any outstanding charges. We’ll send any remaining 
portion of the Deposit to your last known address within 90 days after your final invoice – if 
it is returned to us, we will forward it on to the appropriate state authorities to the extent 
required by law.

Restrictions On Using Services
You can’t use our Services: (a) in a way that could cause damage or adversely affect any of 
our other customers or our reputation, network, property or Services; or (b) in any way 
prohibited by the terms of our Services, the Agreement or our Policies. You cannot in any 
manner resell the Services to another party. See our Acceptable Use Policy and Visitor 
Agreement, which is available on our website, for additional restrictions on the use of our 
Services.

Your Device, Number & E-mail Address; Caller ID
We don’t manufacture any Device we might sell to you or that is associated with our 
Services, and we aren’t responsible for any defects, acts or omissions of the manufacturer. 
The only warranties on your Device are the limited warranties given to you by the 
manufacturer directly or that we pass through. Your Device is designed to be activated on the 
Sprint network and in other coverage areas we make available to you. As programmed, it will 
not accept wireless service from another carrier. Except for any legal right you may have to 
port/transfer your phone number to another carrier, you have no and cannot gain any (for 
example, through publication, use, etc.) proprietary, ownership or other rights to any phone 
number, identification number, e-mail address or other identifier we assign to you, your 
Device or your account. We’ll notify you if we decide to change or reassign them. Your 
CDMA Sprint PCS phone has a software programming lock that protects certain of the 
handset’s operating parameters against unauthorized reprogramming. If you wish to obtain 
the software program lock code for your CDMA Sprint PCS phone, please visit Sprint.com or 
call 1-888-211-4727 for information and eligibility requirements.
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Porting/Transferring Phone Numbers
We don’t guarantee that number transfers to or from us will be successful. If you authorize 
another carrier to transfer a number away from us, that is considered a request by you to us to 
terminate all of the Services associated with that number. You’re responsible for all charges billed 
or incurred prior to deactivation and for any applicable Early Termination Fees.

Coverage; Where Your Device Will Work; Service Speeds
Our coverage maps are available at our stores and on our website. The specific network 
coverage you get will depend on the radio transmissions your Device can pick up and Services 
you’ve chosen. Our coverage maps provide high level estimates of our coverage areas when 
using Services outdoors under optimal conditions. Coverage isn’t available everywhere and 
Service speeds are not guaranteed. Service speeds may depend on the Service purchased. Actual 
speeds will vary. Estimating wireless coverage, signal strength, and Service speed is not an exact 
science. There are gaps in coverage within our estimated coverage areas that, along with other 
factors both within and beyond our control (network problems, network or Internet congestion, 
software, signal strength, your Device, structures, buildings, weather, geography, topography, 
server speeds of the websites you access, etc.), may result in dropped and blocked connections, 
slower Service speeds, or otherwise impact the quality of Service. Services that rely on location 
information, such as E911 and GPS navigation, depend on your Device’s ability to acquire satellite 
signals (typically not available indoors) and network coverage. While your Device is receiving a 
software update, you may be unable to use your Device in any manner until the software update 
is complete.

Roaming
The term “roaming” typically refers to coverage on another carrier’s network that we may make 
available to you based on our agreements with other carriers. These agreements may change 
from time to time and roaming coverage is subject to change. Your ability to receive roaming 
coverage depends on the radio transmissions your Device can pick up and the availability of 
roaming coverage. We make no guaranty that roaming coverage will be available. Roaming 
coverage may exist both within and outside our network coverage areas. Your Device will 
generally indicate when you’re roaming. Depending on your Services, separate charges or 
limits on the amount of minutes used while roaming may apply. Certain Services may not be 
available or work the same when roaming (including data Services, voicemail, call waiting, etc.).

About Data Services & Content
Our data Services and your Device may allow you to access the internet, text, pictures, video, 
games, graphics, music, email, applications, sound and other materials (“Data Content”) or send 
Data Content elsewhere. Some Data Content is available from us or our vendors, while other 
Data Content can be accessed from others (third party websites, games, ringers, etc.). We make 
absolutely no guarantees about the Data Content you access on your Device. Data Content may 
be: (1) unsuitable for children/minors; (2) unreliable or inaccurate; or (3) offensive, indecent or 
objectionable. You’re solely responsible for evaluating the Data Content accessed by you or 
anyone on your account. We strongly recommend you monitor data usage by children/minors. 
Data Content from third parties may also harm your Device or its software. To protect our 
network, Services, or for other reasons, we may place restrictions on accessing certain Data 
Content (such as certain websites, applications, etc.), impose separate charges, limit throughput 
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or the amount of data you can transfer, or otherwise limit or terminate Services. If we provide 
you storage for Data Content you have purchased, we may delete the Data Content with 
notice or place restrictions/limits on the use of storage areas. You may not be able to make 
or receive voice calls while using data Services. Data Content provided by our vendors or 
third parties is subject to cancellation or termination at any time without notice to you and 
you may not receive a refund for any unused portion of the Data Content.

Specific Terms & Restrictions On Using Data Services
In addition to the rules for using all of our other Services, unless we identify the Service or 
Device you have selected as specifically intended for that purpose (for example, wireless 
routers, Data Link, etc.), you can’t use our data Services: (1) with server devices or host 
computer applications, or other systems that drive continuous heavy traffic or data 
sessions; (2) as a substitute or backup for private lines or frame relay connections; or (3) for 
any other unintended use as we determine in our sole discretion. We reserve the right to 
limit, suspend or constrain any heavy, continuous data usage that adversely impacts our 
network performance or hinders access to our network. If your Services include web or 
data access, you also can’t use your Device as a modem for computers or other 
equipment, unless we identify the Service or Device you have selected as specifically 
intended for that purpose (for example, with “phone as modem” plans, Sprint Mobile 
Broadband card plans, wireless router plans, etc.).

Activation & Miscellaneous Charges
Based on our Policies, we may charge activation, prepayment, reactivation, program or 
other fees to establish or maintain Services. Certain transactions may also be subject to a 
charge (for example, convenience payment, changing phone numbers, handset upgrades, 
etc.). You will be provided notice of these types of fees before we complete the requested 
transaction.

Account & Service Charges
You are responsible for all charges associated with your account and the Services on your 
account, no matter who adds or uses the Services. Charges include, but are not limited to, the 
monthly recurring charges, usage charges, charges for additional services, taxes, surcharges 
and fees associated with your Services. These charges are described or referred to during 
the sales transaction, in our marketing materials, and in confirmation materials we may send 
to you. Depending on your Services, charges for additional services may include operator 
and directory assistance, voicemail, call forwarding, data calls, texts and web access. If you 
(the account holder) allow end users to access or use your Devices, you authorize end users 
to access, download use Services. For Services offered on a per-day basis, you will generally 
be charged for use before or at the time of use. In certain instances, we may charge at some 
point after you use the Services. Services offered on a per-day basis end 24 hours after 
Service is initiated. You may have the opportunity to purchase Services on a subscription 
basis where we assess “subscription charges” – charges that allow you access to the 
Services and/or provide you a certain amount of use of the Services for a defined period of 
time. Depending on your Service, certain types of subscription charges may be assessed 
automatically upon activation and automatically assessed for subsequent subscription 
periods. Subscription services offered on a recurring basis do not end until terminated by 
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you or us. Subscription charges for recurring Services occur at the beginning of each bill cycle. 
Information regarding your bill cycle for subscription Services will be provided when you order 
the Services.

How We Calculate Your Charges For Billing Purposes
Regular Voice Calls: We round up partial minutes of use to the next full minute. Time starts when 
you press “Talk” or your Device connects to the network and stops when you press “End” or the 
network connection otherwise breaks. You’re charged for all calls that connect, even to 
answering machines. You won’t be charged for unanswered calls or if you get a busy signal. For 
incoming calls answered, you’re charged from the time shortly before the Device starts ringing 
until you press END or the network connection otherwise breaks. If charges vary depending on 
the time of day that you place or receive calls (for example, Nights and Weekend plans), you’re 
charged for the entire call based on the rate that applies to the time period in which the call 
starts.

Walkie-Talkie Charges: Charges for walkie-talkie calls are billed to the person who starts the call 
and calculated by multiplying the duration of the call by the applicable rate and number of 
participants. You’re charged at least 6 seconds of airtime for each call you start; subsequent 
communications in the same call are rounded up to and billed to the next second. Time begins 
when you press any button to start a walkie-talkie call and ends approximately 6 seconds after 
completion of a communication to which no participant responds – subsequent walkie-talkie 
communications are considered new calls. Depending on your plan, nationwide, international or 
group walkie-talkie calls may use the local walkie-talkie minutes in your plan and result in 
additional charges. Responses to call alert transmissions are treated as new walkie-talkie 
transmissions even when responding within 6 seconds of receiving the alert. Walkie-talkie billing 
methods are subject to change as we introduce new walkie-talkie Services. 

Data Usage: Unless we specifically tell you otherwise, data usage is measured in bytes, kilobytes, 
megabytes, and gigabytes – not in minutes/time. 1024 bytes equals 1 kilobyte (“KB”), 1024 KB 
equals 1 megabyte (MB), and 1024 MB equals 1 gigabyte. Bytes are rounded up to kilobytes, so 
you will be charged at least 1 KB for each data usage session (“data session”). Rounding 
occurs at the end of each data session, and sometimes during a data session. Depending on 
your data Services, usage may be charged against an allowance or on a fixed price per KB, and 
you may be subject to limitations on the amount of data usage. If you are charged on a fixed 
price per KB, any fractional cents will be rounded up to the next cent. You are charged for all 
data directed to your Device’s internet address, including data sessions you did not initiate and 
for incomplete transfers. As long as your Device is connected to our data network, you may incur 
data charges. Examples of data you will be charged for includes the size of a requested file or 
Data Content (game, ringer, etc.), web page graphics (logos, pictures, banners, advertisement, 
etc.), additional data used in accessing, transporting and routing the file on our network, data 
from partial or interrupted downloads, re-sent data, and data associated with unsuccessful 
attempts to reach websites or use applications. These data charges are in addition to any 
charges for the Data Content itself (game, ringer, etc.). Data used and charged to you will vary 
widely, even between identical actions or data sessions. Estimates of data usage – for example, 
the size of downloadable files – are not reliable predictors of actual usage. Your bill won’t 
separately list the number of KB attributed to a specific action/data session.
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Your Bill
Your bill provides you notice of your charges. It reflects monthly recurring charges (usually 
billed one bill cycle in advance) and usage/transaction specific charges (usually billed in the 
bill cycle in which they’re incurred). Some usage charges, such as those that depend on 
usage information from a third party, may be billed in subsequent bill cycles and result in 
higher than expected charges for that month. Bill cycles and dates may change from time to 
time. Your bill may also include other important notices (for example, changes to this 
Agreement, to your Service, legal notices, etc.). Your paper bill may not include itemized 
billing detail. More specific billing information is available online. Paper bills with itemized 
detail may be subject to an additional charge. Unless prohibited by law, other charges (for 
example, data Services or taxes and surcharges) will not include itemized detail but will be 
listed as total charges for a category. If you choose internet billing, you will not receive paper 
bills.

Your Payments; Late Fees 
Payment is due in full as stated on your bill. If we do not receive payment in full by the date 
specified on your bill, a late payment charge, which may be charged at the highest rate 
permissible by law, may be applied to the total unpaid balance. We may also charge you 
any costs we pay to a collection agency to collect unpaid balances from you. If we bill you 
for amounts on behalf of a third party, payments received are first applied to our charges. 
You may be charged additional fees for certain methods of payment. We may charge you, 
up to the highest amount permitted by law, for returned checks or other payments paid by 
you and denied for any reason by a financial institution. Acceptance of payments (even if 
marked “paid in full”) does not waive our right to collect all amounts that you owe us. We 
may restrict your payment methods to cashier’s check, money order, or other similar secure 
form of payment at any time for good reason.

Taxes & Government Fees 
You agree to pay all federal, state and local taxes, fees and other assessments that we’re 
required by law to collect and remit to the government on the Services we provide to you. 
These charges may change from time to time without advance notice. If you’re claiming any 
tax exemption, you must provide us with a valid exemption certificate. Tax exemptions 
generally won’t be applied retroactively.

Surcharges 
You agree to pay all surcharges (“Surcharges”), which may include, but are not limited to: 
Federal Universal Service, various regulatory charges, Sprint administrative charges, gross 
receipts charges, and charges for the costs we incur in complying with governmental 
programs. Surcharges are not taxes and are not required by law. They are rates we choose to 
collect from you and are kept by us in whole or in part. The number and type of Surcharges 
may vary depending upon the location of the billing address of the Device and can change 
over time. We determine the rate for these charges and these amounts are subject to change 
as are the components used to calculate these amounts. We will provide you notice of any 
changes to Surcharges in a manner consistent with this Agreement (see “Providing Notice 
To Each Other Under The Agreement” section). However, since some Surcharges are based 
on amounts set by the government or based on government formulas, it will not always be 
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possible to provide advance notice of new Surcharges or changes in the amount of existing 
Surcharges. Information on Surcharges is provided during the sales transaction and is available 
on our website.

Disputing Charges - You Must Still Pay Undisputed Charges 
Any dispute to a charge on your bill must be made within 60 days of the date of the bill that initially 
contained the charge. Disputes can only be made by calling or writing us as directed on your invoice 
or elsewhere. You accept all charges not properly disputed within the above time period – undisputed 
charges must still be paid as stated on your bill.

Protecting Our Network & Services 
We can take any action to: (1) protect our network, our rights and interests, or the rights of 
others; or (2) optimize or improve the overall use of our network and Services. Some of these 
actions may interrupt or prevent legitimate communications and usage – for example, message 
filtering/blocking software to prevent SPAM or viruses, limiting throughput, limiting access to 
certain websites, applications or other Data Content, prohibitions on unintended uses (for 
example, use as a dedicated line, or use as a monitoring service), etc. For additional 
information on what we do to protect our customers, network, Services and equipment, see our 
Acceptable Use Policy and Visitor Agreement at our website.

Your Privacy 
Our Privacy Policy is available on our website. To review the policy, visit www.sprint.com/legal/
privacy.html. This policy may change from time to time, so review it with regularity and care. 

Call Monitoring: To ensure the quality of our Services and for other lawful purposes, we may 
monitor or record calls between us (for example, your conversations with our customer service 
or sales departments).

Authentication and Contact: You (the accountholder) may password protect your account 
information by establishing a personal identification number (“PIN”). You may also set a backup 
security question and answer in the event you forget your PIN. You agree to protect your PIN, 
passwords and other account access credentials like your backup security question from loss 
or disclosure. You further agree that Sprint may, in our sole discretion, treat any person who 
presents your credentials for account access as you or an authorized user on the account for 
disclosure of information or changes in Service. You agree that we may contact you for Service 
related reasons through the contact information you provide, through the Services or Devices to 
which you subscribe or through other available means, including text message, email, fax, 
recorded message, mobile, residential or business phone, or mail.

CPNI: As we provide telecommunications products and Services to you (the account holder), 
we develop information about the quantity, technical configuration, type and destination of 
telecommunications products and Services you use, as well as some other information found 
on your bill (“CPNI”). Under federal law, you have the right, and we have a duty, to protect the 
confidentiality of your CPNI. For example, we implement safeguards that are designed to protect 
your CPNI, including authentication procedures when you contact us. For some accounts with a 
dedicated Sprint representative, we may rely on contacting your pre-established point of contact 
as the standard authentication measure.
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Third-Party Applications: If you use a third-party application, the application may access, 
collect, use, or disclose your personal information or require Sprint to disclose your 
information, including location information (when applicable), to the application provider or 
some other third party. If you access, use, or authorize third-party applications through the 
Services, you agree and authorize Sprint to provide information related to your use of the 
Services or the application(s). You understand that your use of third-party applications is 
subject to the third party’s terms and conditions and policies, including its privacy policy.

Information on Devices: Your Device may contain sensitive or personal information. Sprint is 
not responsible for any information on your Device, including sensitive or personal 
information. If possible, you should remove or otherwise safeguard any sensitive or 
personal information when your Device is out of your possession or control, including, but 
not limited to, relinquishing, exchanging, returning, or recycling your Device. By submitting 
your Device to us, you agree that our employees, contractors, or vendors may access all of 
the information on your Device.

Location-Based Services
Our network generally knows the location of your Device when it is outdoors and/or turned 
on. By using various technologies to locate your Device, we can provide enhanced 
emergency 911 services, and optional location-sensitive services provided by us or a third 
party. Network coverage or environmental factors (such as structures, buildings, weather, 
geography, landscape, and topography) can significantly impact the ability to access your 
Device’s location information and use of location-sensitive services.

You agree that any authorized user may access, use or authorize Sprint or third-party 
location-sensitive applications through the Services. You understand that your use of such 
location-sensitive applications is subject to the application’s terms and conditions and 
policies, including its privacy policy. If you activate location-sensitive services for devices 
used by other authorized users, you agree to inform the authorized user(s) of the terms of 
use for location-sensitive applications and that the Device may be located. For additional 
information on location-sensitive services, see our Privacy Policy at our website.

911 Or Other Emergency Calls
Public Safety Officials advise that when making 911 or other emergency calls, you should 
always be prepared to provide your location information. Unlike traditional wireline phones, 
depending on a number of factors (for example., whether your Device is GPS enabled, 
where you are, whether local emergency service providers have upgraded their equipment, 
etc.), 911 operators may not know your phone number, your location or the location of your 
Device. In certain circumstances, an emergency call may be routed to a state patrol 
dispatcher or alternative location set by local emergency service providers. Enhanced 911 
service (“E911”), where enabled by local emergency authorities, uses GPS technology to 
provide location information. Even when available, however, E911 does not always provide 
accurate location information. If your Device is indoors or for some other reason cannot 
acquire a satellite signal, you may not be located. Some Devices have a safety feature that 
prevents use of the keypad after dialing 911 – you should follow voice prompts when 
interacting with emergency service providers employing IVR systems to screen calls.
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If Your Device Is Lost or Stolen 
Call us immediately if your Device is lost or stolen because you may be responsible for usage 
charges before you notify us of the alleged loss or theft. A lost or stolen Device does not reduce 
or remove your Term Commitment. You will remain liable for any monthly recurring charges 
associated with the Service on your Device after you notify us of the alleged loss or theft. You 
agree to cooperate if we choose to investigate the matter (provide facts, sworn statements, etc.). 
We may not waive any Early Termination Fees if you choose to terminate Services as a result of 
loss or theft of your Device.

Disclaimer of Warranties 
WE MAKE NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED, INCLUDING (TO 
THE EXTENT ALLOWED BY LAW) ANY IMPLIED WARRANTY OF MERCHANTABILITY, NON-
INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE CONCERNING YOUR SERVICES 
(INCLUDING YOUR DEVICE). WE DON’T PROMISE UNINTERRUPTED OR ERROR-FREE 
SERVICES AND DON’T AUTHORIZE ANYONE TO MAKE WARRANTIES ON OUR BEHALF.

You Agree We Are Not Responsible For Certain Problems 
You agree that neither we nor our vendors, suppliers or licensors are responsible for any 
damages resulting from: (a) anything done or not done by someone else; (b) providing or 
failing to provide Services, including, but not limited to, deficiencies or problems with a Device 
or network coverage (for example, dropped, blocked, interrupted Services, etc.); (c) traffic or 
other accidents, or any health-related claims relating to our Services; (d) Data Content or 
information accessed while using our Services; (e) an interruption or failure in accessing or 
attempting to access emergency services from a Device, including through 911, Enhanced 911 
or otherwise; (f) interrupted, failed, or inaccurate location information services, (g) information or 
communication that is blocked by a spam filter, (h) damage to your Device or any computer or 
equipment connected to your Device, or damage to or loss of any information stored on your 
Device, computer, equipment, or Sprint storage space from your use of the Services or from 
viruses, worms, or downloads of malicious content, materials, data, text, images, video or audio; 
or (i) things beyond our control, including acts of God (for example, weather-related 
phenomena, fire, earthquake, hurricane, etc.), riot, strike, war, terrorism or government orders or 
acts. You should implement appropriate safeguards to secure your Device, computer or 
equipment and to back-up your information stored on each.

You Agree Our Liability Is Limited - No Consequential Damages.
TO THE EXTENT ALLOWED BY LAW, OUR LIABILITY FOR MONETARY DAMAGES FOR ANY 
CLAIMS YOU MAY HAVE AGAINST US IS LIMITED TO NO MORE THAN THE PROPORTIONATE 
AMOUNT OF THE SERVICE CHARGES ATTRIBUTABLE TO THE AFFECTED PERIOD. UNDER 
NO CIRCUMSTANCES ARE WE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL, PUNITIVE 
OR SPECIAL DAMAGES OF ANY NATURE WHATSOEVER ARISING OUT OF OR RELATED TO 
PROVIDING OR FAILING TO PROVIDE SERVICES IN CONNECTION WITH A DEVICE, 
INCLUDING, BUT NOT LIMITED TO, LOST PROFITS, LOSS OF BUSINESS, OR COST OF 
REPLACEMENT PRODUCTS AND SERVICES.
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DISPUTE RESOLUTION 

We Agree To First Contact Each Other With Any Disputes

We each agree to first contact each other with any disputes and provide a written description of 
the problem, all relevant documents/information and the proposed resolution. We agree to 
contact each other as described in the Providing Notice to Each Other Under The Agreement 
section of the Ts&Cs.

Instead Of Suing In Court, We Each Agree To Arbitrate Disputes

We each agree to finally settle all disputes (as defined and subject to any specific exceptions 
below) only by arbitration. In arbitration, there’s no judge or jury and review is limited. However, 
just as a court would, the arbitrator must honor the terms and limitations in the Agreement and 
can award the same damages and relief, including any attorney’s fees authorized by law. The 
arbitrator’s decision and award is final and binding, with some exceptions under the Federal 
Arbitration Act (“FAA”), and judgment on the award may be entered in any court with jurisdiction. 
We each also agree as follows:

(1) “Disputes” are any claims or controversies against each other related in any way to 
our Services or the Agreement, including, but not limited to, coverage, Devices, privacy, 
or advertising, even if it arises after Services have terminated – this includes claims you 
bring against our employees, agents, affiliates or other representatives, or that we bring against 
you.

(2) If either of us wants to arbitrate a dispute, we agree to send written notice to the other 
providing a description of the dispute, previous efforts to resolve the dispute, all supporting 
documents/information, and the proposed resolution. Notice to you will be sent as described in 
the Providing Notice to Each Other Under The Agreement section of the Ts&Cs and notice to us 
will be sent to: General Counsel; Arbitration Office; 2001 Edmund Halley Drive VARESP0513-502; 
Reston, Virginia 20191. We agree to make attempts to resolve the dispute. If we cannot resolve 
the dispute within forty-five (45) days of receipt of the notice to arbitrate, then we may submit the 
dispute to formal arbitration.

(3) The FAA applies to this Agreement and arbitration provision. We each agree the FAA’s 
provisions, not state law, govern all questions of whether a dispute is subject to arbitration.

(4) Unless we each agree otherwise, the Arbitration will be conducted by a single neutral 
arbitrator and will take place in the county of the last billing address of the Device. We will agree 
on the arbitrator, and if we cannot agree, then the arbitrator will be appointed by the court as 
provided by the FAA.

(5) The arbitration will be governed by the arbitration rules selected by the Arbitrator. The federal 
or state law that applies to the Agreement will also apply during the arbitration.

(6) We each agree not to pursue arbitration on a classwide basis. We each agree that any 
arbitration will be solely between you and us (not brought on behalf of or together with 
another individual’s claim). If for any reason any court or arbitrator holds that this 
restriction is unconscionable or unenforceable, then our agreement to arbitrate doesn’t 
apply and the dispute must be brought in court. 

(7) We each are responsible for our respective costs relating to counsel, experts, and witnesses, 
as well as any other costs relating to the arbitration. However, we will cover any arbitration 
administrative or filing fees above: (a) $25 if you are seeking less than $1,000 from us; or (b) the 
equivalent court filing fees for a court action in the appropriate jurisdiction if you are seeking 
$1,000 or more from us.

Exceptions To Our Agreement To Arbitrate Disputes

Either of us may bring qualifying claims in small claims court. In addition, this arbitration 
provision does not prevent you from filing your dispute with any federal, state or local 
government agency that can, if the law allows, seek relief against us on your behalf.
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No Class Actions 
TO THE EXTENT ALLOWED BY LAW, WE EACH WAIVE ANY RIGHT TO PURSUE DISPUTES ON 
A CLASSWIDE BASIS; THAT IS, TO EITHER JOIN A CLAIM WITH THE CLAIM OF ANY OTHER 
PERSON OR ENTITY, OR ASSERT A CLAIM IN A REPRESENTATIVE CAPACITY ON BEHALF OF 
ANYONE ELSE IN ANY LAWSUIT, ARBITRATION OR OTHER PROCEEDING.

No Trial By Jury 
TO THE EXTENT ALLOWED BY LAW, WE EACH WAIVE ANY RIGHT TO TRIAL BY JURY IN ANY 
LAWSUIT, ARBITRATION OR OTHER PROCEEDING.

Indemnification 
You agree to indemnify, defend and hold us harmless from any claims arising out of your 
actions, including, but not limited to, your use of the Service and any information you submit, 
post, transmit or make available via the Service, failing to provide appropriate notices regarding 
location-sensitive services (see “Location Based Services” section), failure to safeguard your 
passwords, backup question to your shared secret question or other account information, or 
violating this Agreement or any policy referenced in this Agreement, any applicable law or 
regulation or the rights of any third party.

Providing Notice To Each Other Under The Agreement 
Except as the Agreement specifically provides otherwise, you must provide us notice by calling 
or writing us as instructed on your invoice. We will provide you notice through one or more of 
the following: in your bill, correspondence to your last known billing address, to any fax number 
or e-mail address you’ve provided us, by calling you on your Device or any other phone 
number you’ve provided us, by voice message on your Device or any other phone number 
you’ve provided us, or by text message on your Device.

Other Important Terms 
Subject to federal law or unless the Agreement specifically provides otherwise, this Agreement 
is governed solely by the laws of the state encompassing the billing address of the Device, 
without regard to the conflicts of law rules of that state. If either of us waives or doesn’t enforce a 
requirement under this Agreement in an instance, we don’t waive our right to later enforce that 
requirement. Except as the Agreement specifically provides otherwise, if any part of the 
Agreement is held invalid or unenforceable, the rest of this Agreement remains in full force and 
effect. This Agreement isn’t for the benefit of any 3rd party except our corporate parents, 
affiliates, subsidiaries, agents, and predecessors and successors in interest. You can’t assign 
the Agreement or any of your rights or duties under it. We can assign the Agreement. You 
cannot in any manner resell the Services to another party. The Agreement and the documents 
it incorporates make up the entire agreement between us and replaces all prior written or 
spoken agreements – you can’t rely on any contradictory documents or statements by sales or 
service representatives. The rights, obligations and commitments in the Agreement that, by their 
nature, would logically continue beyond the termination of Services (including, but not limited 
to, those relating to billing, payment, 911, dispute resolution, no class action, no jury trial), survive 
termination of Services.
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